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Safetyinformation
Owner's Record
The model number and serial number are located on the back of your 
Sony PC. Record the serial number in the space proc’ided here. Refer to 
the model and serial number when you call your Sony Service Center.

Model Number: PCV-70, PCV-90

Serial Number:_______________________________________

WARNING

□ To prevent fire or shock hazard, do not expose your Sony PC to rain 
or moisture.

□ Never install modem or telephone wiring during a lightning storm.
□ Never install telephone jacks in wet locations unless the jack is 

specifically designed for wet locations
□ Never touch uninsulated telephone wire or terminals unless the 

telephone line has been disconnected at the network interface.
□ Use caution when installing or modifying telephone lines.
□ Avoid using the modem during an electrical storm.
□ Do not use the modem or a telephone to report a gas leak in the 

vicinity of the leak.
Caution
A\The use of optical instruments with your Sony PC will increase eye hazard.
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Welcome

Congratulations on your purchase of the Sony PC. Sony has
combined leading-edge technology in audio, video, computing, and
communications to provide you with state-of-the-art personal
computing.

Here are just some of the features your Sony PC has to offer.

□ Exceptional performance: Your PC includes a fast Intel® Pentium® 
processor, an 8x CD-ROM drive, and a 28.8 Kbps DSVD (Digital 
Simultaneous Voice Data) modem.

□ Sxmy audio and video quality; High-quality, "Sony Tuned" video, 
which supports full-screen display, and integrated 3-D sound enable 
you to take advantage of today's advanced multimedia applications, 
games, and entertainment software.

□ Preinstalled software titles; Your Sony PC includes dozens of best­
selling software titles, including productivity and reference tools, 
multimedia applications, and games featuring advanced 3-D 
graphics.

□ Windows® 95: Your system includes the latest operating system 
from Microsoft.

□ VAIO^'^ Space: This fun, friendly, and engaging desktop 
environment, developed especially for the Sony PC, helps you 
organize and launch applications quickly and efficiently.

□ Sony A/V Suite; Enjoy all of your PC's audio and visual capabilities 
with component-like applications that play audio CDs, audio files 
(MIDI and WAV), Video CDs, and video files.

□ Communications: Access popular online services, send e-mail, 
browse the Internet, and use the built-in speakerphone, answering 
machine, and fax features.

□ Excellent customer support: Click the SOS icon to access Sony Online 
Support 24 hours a day, seven days a week. The SOS software 
enables a support representative to talk to you on the phone, perform 
remote diagnostics on your PC, and send you updates, all through a 
single phone call.
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□

□

About this User Guide
This user guide offers a quick introduction and reference to your 
Sony PC.

□ Setting Up Your Sony PC shows you how to connect the standard 
components of your system—generally in under 15 minutes. This 
section also explains how to connect additional components you may 
have purchased, such as a printer, a MIDI instrument, and a joystick.
Getting Started with VAIO Space offers an in-depth exploration of 
the VAIO Space environment. It explains the different areas of the 
screen, how to launch applications, how to switch to Windows 95, 
how to customize your settings, and more.
Introducing the Sony A/V Suite describes how to use the audio and 
video components of the Sony A/V Suite. For instance, learn how to 
listen to your favorite CDs while you work on the computer, or watch 
videos on your computer screen.
Getting Help explains the support options available to you, shows 
you how to use the Sony Online Support service, and offers basic 
troubleshooting tips.
Upgrading and Maintaining Your Sony PC illustrates how to install 
an add-in card and memory, as well as how to change the lithium 
battery in your PC.
Computer Basics shows new computer users how to use a mouse, 
keyboard, CD-ROM drive, and diskette drive.
Other Information provides facts and advice about using your PC, as 
well as regulatory information.

□

□

□
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Setting Up Your Sony PC

Your Sony PC comes with all the software titles preinstalled on your hard 
disk drive. Just follow these simple steps to connect the cables and turn 
on the PC, and your Sony PC is ready to use.

Unpacking Your PC
Remove the following items from the box:

System Unit D'sp'ay (sold separately)

Power Cord

Phone Cable

You can find the complete list of the items that come with your PC in the 
About Your Sony PC guide.

Note
^ If you purchased a Sony Multimedia Computer Display, it includes built-in speakers 

and a microphone. For other displays, you'll need separate speakers and a microphone 
to use the Sony PC's audio features.



Setting Up Your Sony PC

Choosing a Location for Your PC
Here are some things to consider when planning vour workspace:

J Stable work surface—Use a stable work surface large enough to 
support the computer, the display, and other equipment.

_J Ventilation—Leave at least eight inches of space on the left and back 
sides of your PC to enable proper ventilation.

J Placement of the keyboard, mouse, and other input devices—Place 
your keyboard, mouse, and other input devices so that your arms 
and hands are in a relaxed, comfortable position. The keyboard 
should be directly in front of you. Adjust the level of the keyboard so 
that your lower arms are parallel to the floor. Keep your wrists in a 
relaxed position when you're using the keyboard—not angled up or 
down. Use the palmrest only briefly, for resting. While typing, never 
use the palmrest or rest your hands on the table. Position the mouse 
at the same level as the keyboard. Hold the mouse with a relaxed 
hand, and use your whole arm to move it. Take breaks during 
sessions with your PC. Excessive use of the mouse or a joystick may 
strain muscles or tendons.



Choosing a Location for Your PC

Furniture and posture—Sit in a chair with good back support and 
armrests. Adjust the level of the chair so your feet are flat on the floor. 
A footrest may make you more comfortable. Sit in a relaxed, upright 
posture—avoid slouching forward or leaning far backward.
Viewing angle of the display—Position the display 18 to 26 inches 
directly in front of you, with the top of the screen at or a little below 
eye level. Use the display's tilting feature to find the best position. 
You can reduce eye strain and muscle fatigue by placing the display 
in the proper position.
Lighting—Choose a location where windows and lights do not create 
glare and reflection on the display. Use indirect lighting to avoid 
bright spots on the display. You can also purchase accessories for 
your display that help reduce glare. Proper lighting adds to your 
comfort and work effectiveness.



Setting Up Your Sony PC

Back Panel Overview
The back panel of your Sony PC contains the connectors where you plug 
in supplied and optional accessories. The icons on the back panel serve as 
a map to help you locate the connectors on your PC.

Icon Map of Connectors (color coded)

Power

Mouse

Keyboard

USB

Printer

Monitor

Headphones 

Line In 

Microphone 

Game/MIDI

Line

Phone



Connecting the Sony Multimedia Computer Display

Connecting the Sony 
Multimedia Computer Display
The Sony Multimedia Computer Display (sold separately) is an
integrated audio/video unit with built-in speakers and a microphone.
Follow these steps to connect it to your PC.

1 Use the blue (3 symbol to locate the MONITOR connector. Plug the 
blue display cable into this connector, and then tighten the two 
screws to secure the cable.

2 Use the green Q symbol to locate the HEADPHONES connector. Plug the 
green speaker cable into this connector.

3 Use the red y* symbol to locate the MIC connector. Plug the red 
microphone cable into this connector.

^ See the manual that came with your Sony Multimedia Computer Display for more 
information on setting up and using the display.



Setting Up Your Sony PC

Connecting a Display, Speakers, 
and a Microphone
If you did not purchase the Sony Multimedia Computer Display, you
need speakers and a microphone to use the Sony PC's audio features.

Note
A Make sure your speakers are designed for computer use. Contact your Sony dealer 

for information on purchasing Sony computer speakers.

Follow these steps to connect your display,, speakers, and microphone.

1 Use the blue (3) symbol to locate the MONITOR connector. Plug the 
display cable into this connector, and then tighten the two screws to 
secure the cable.

2 Use the green Q symbol to locate the HEADPHONES connector. Plug the 
speaker cable into this connector.

3 Use the red y* to locate the MIC connector. Plug the microphone cable 
into this connector.

^ See the manuals that came with your display, speakers, and microphone for more 
information on setting them up and using them.

8



Connecting the Optional Palmrest

Your Sony PC is equipped with an optional palmrest that you can attach 
to your keyboard. Follow these steps to connect the palmrest.

1 Place the keyboard and palmrest upside down on a flat surface.

2 Insert the latching posts on the palmrest into the openings on 
the keyboard.

3 Move the palmrest to the right until you feel it snap into place.

Connecting the Optional Palmrest

^ Do not keep your wrists on the palmrest while typing: use the palmrest briefly only 
when resting.

To remove the palmrest

1 Turn the keyboard and palmrest upside down.

2 Push down on the palmrest, and then move it to the left.

3 Lift the palmrest away from the keyboard.



Setting Up Your Sony PC

Follow these steps to connect the keyboard and mouse.

1 Use the purple iVijVl symbol to locate the KEYBOARD connector. Plug the 
purple keyboard cable into this connector.

2 Use the blue-green CZB" symbol to locate the MOUSE connector and 
insert the blue-green mouse cable into this connector.

Connecting the Keyboard and Mouse

the keyboard and mouse.
information on setting up and using

10



Connecting the Phone Line and Phone

You need to connect the phone line and phone to take advantage of 
online services, the Internet, and Sony Online Support. The phone line 
also enables you to register your PC and software online.

There are two phone jacks on the back panel. Follow these steps to 
connect your phone line and phone.

1 Unplug your phone from the wall jack and plug it into the PHONE jack 
on the PC.

2 Plug one end of the phone cable that came with your system into the 
LINE jack and the other end into the wall jack.

Connecting the Phone Line and Phone

Note
^ Your Sony PC does not work with party lines, cannot be connected to a coin-operated 

telephone, and may not work with multiple phone lines or a private branch exchange 
(PBX).

11



Setting Up Your Sony PC

Connecting the Power Cords
Your Sony PC is shipped with the voltage switch set to 115 volts. This is 
the correct setting for most homes and businesses in North America. If 
you use the PC in a location that requires 230 volts, change the setting to 
230 volts by moving the switch up.

Caution
A Do not ii.'ii’ your Sony PC with the incorrect voltage setting; this may damage 

the PC. ' '

Follow these steps to connect the power cords.

1 Plug the power cord into the connector on the PC.

If necessary, plug the display power cord into the display.2
3 Plug both the display and power cords into a grounded AC wall 

outlet, power strip, or Uninterrupted Power Supply.

12



Connecting Additional Components

Connecting Additional Components
You can add functionality to your Sony PC by connecting a printer, 
joystick, or MIDI device.

Connecting a Printer
You can connect a printer to your Sony PC to print documents from 
your PC.

1 Use the dark grey symbol to locate the PRINTER connector. Plug 
the printer cable into this connector.

2 If necessary, plug one end of the printer power cord into the 
printer, and the other end into a grounded AC wall outlet, power

~?trip, or Uninterrupted Power Supply.

^ See the manual that came with your printer fpr more information on setting it up 
and using it.

13



Setting Up Your Sony PC

Connecting a Joystick or MIDI Instrument
You can connect a joystick or MIDI instrument to your Sony PC. You can 
also purchase an adapter to connect additional devices.

□ Use the dark grey ^ symbol to locate the GAME connector. Plug 
the joystick or MIDI cable into this connector.

Note
^ Your MIDI instrument may have a different type of cable which requires an

adapter. See the manual that came with your joystick or MIDI instrument for more 
information on setting it up and using it.

14



Starting Your Sony PC

Starting Your Sony PC
After you connect all the cables and accessories to your Sony PC, you're 
ready to turn on the PC.

1 Press the power switch on the display to turn on the power.

2 Press the power switch on the upper-left panel of the PC to turn on 
the power.

Note
^ See "Shutting Down Your Sony PC" on page 35 for instructions on turning off 

your PC.
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Setting Up Your Sony PC

Registering Windows 95
The first time you turn on your Sony PC, you need to complete a few 
steps to register and configure the Windows 95 software that is already 
installed on your PC. You do not need to repeat these steps each time you 
turn on your computer.

Note
A You must register Windoivs 95 before you can use your PC.

The on-screen instructions guide you through the registration and 
configuration process. The following is an overview of the process.

1 Gathering information:

□ Enter your name.
-j Read and accept the License Agreement.
□ Enter your Certificate of Authenticity number located on the 

cover of the Introducing Windou’s 95 manual.

2 Configuring your computer:

□ Click the Next button on the Network card detection screen.
□ Wait for the Registration program to install the software required 

to use the devices included with your PC.

3 Restarting your computer:

□ Click the Einish button when the Einishing Setup screen appears.
□ Click the OK button, and then wait for your computer to restart.

4 Selecting your computer settings:

□ If necessary, change the Time Zone, Date and Time on the Date/ 
Time Properties screen.

5 Learning about Windows 95:

□ If you want, take the tour of Windows 95.

16



Registering Your PC

Registering Your PC
Take advantage of Sony's commitment to quality customer support and 
receive these benefits by registering your Sony PC:

□ Sony Online Support—Talk to a Support Representative to 
troubleshoot problems you may be having with your PC.

□ One-year parts and labor warranty—Protect your investment. See 
the Limited Warranty Card for details.

□ On-site service—Provides convenient resolution of any problems. 
Follow these steps to use the Sony PC online registration service.

Note
You must connect your phone and phone line before usin^ any online service . 
including the online registration service. See "Connecting the Phone Line and 
Phone" on page 11.

1 Enter the information requested on the first online registration form. 
Press the TAB key to move from box to box.

2 Click the Next button to advance to the next form.

3 Complete the remaining forms by clicking the Next button each time 
you complete a form.

4 Click the Register Now button to register your PC. The Sony PC 
automatically transfers your regisfration information using your 
built-in modem and a toll-free felephone number.

17



Setting Up Your Sony PC

Accessing the CD-ROM and Diskette Drives
You need to open the front panel to access the CD-ROM and diskette 
drives. Follow these steps to open and close the front panel.

1 Push in the lower front panel on your PC.

2 Slide the upper panel down to reveal the CD-ROM and diskette 
drives.

Note
^ If you installed additional drives, you can access these drives by sliding the front 

panel down to the second position.

18



Accessing the CD-ROM and Diskette Drives

3 After you finish using the CD-ROM and diskette drive, slide the 
upper panel up until you hear the lower panel click into place.

19
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Getting Started with VAIO Space

What Is VAIO Space?
Sony VAIO Space is a desktop environment you can use to:

□ Launch applications
□ Connect to online services
□ Access the components in the Sony A/V Suite to watch videos, 

play CDs, work with sound files, and more
VAIO Space organizes all your preinstalled software, offering easy access 
to youjLSpplications. The 3-D graphics, animated icons, and movie clips 
in the center of the screen make the VAIO Space desktop a distinctive PC 
environment.

VAIO Space and Windows 95 work together so that you can easily 
switch back and forth between the two desktops. You can even choose 
which desktop appears when you turn on your PC—VAIO Space or 
Windows 95.

21



Il Getting Started with VAIO Space

The VAIO Space Screen
As you look at the VAIO Space screen, imagine that you are standing in a 
room looking at three walls and a ceiling open to the sky.

Wall

Wall

Wall

Floor

Area
Sky

Walls

Floor

Description
Here you can connect to online services, launch an Internet 
browser, go directly to the Sony World Wide Web site, and 
access Sony Online Support.
VAIO Space contains three walls: the Video Wall, the A/V 
Wall, and the Application Wall.
The Floor offers instant access to a variety of common 
tasks, such as getting help and switching to Windows 95.

The wall in the center is the active wall—the one that you can currently 
use. To move a wall or the Sky to the center, just place the mouse pointer 
on it, and click when you see a green arrow.

22



Exploring the Sky

Exploring the Sky
The VAIO Space Sky lets you access online services, Internet browsers, 
and Sony Online Support.

The Sky contains two animated icons and the Net Space window, which 
appears when you click an empty part of the Sky. The Sony Online and 
SOS icons are available for you to use when they are spinning. If the icons 
are not currently moving, you need to close any open windows to make 
the icons available.

Icon Description
Launches an Internet browser and displays the Sony World 
Wide Web site.

Sony Online

Launches the SOS program and connects to Sony Online 
Support where you can speak to a support representative.

Using Sony Online
Sony Online gives you direct access to the Sony World Wide Web site. 
You can use your existing Internet Service Provider or establish a new 
account with an online service. Unless you are using a network, you must 
complete the account setup process the first time you use an Internet 
Service Provider to access Sony Online;

To complete account setup

1 Click the Sony Online icon.

2 Select Modem.

3 Click the New Connection button.

4 Follow the on-screen instructions to complete the account 
setup process.

23



i Getting Started with VAIO Space

Using SOS
The SOS icon connects you to Sony Online Support. You can use SOS to 
exchange information with a Sony customer service representative. For 
details on using SOS, see "Calling SOS" on page 80.

To start SOS

1 Click the SOS icon.

2 Complete the on-screen form.

3 Click the Call SOS button.

Using Net Space
The Net Space window enables you to launch online services and Internet 
browsers. To use these, you must first subscribe to an online service or 
establish an account with an Internet Service Provider.

To launch an application from Net Space

1 Close any open windows.

Place the mouse pointer in an empty area of the Sky.2
3

4
5

When the pointer turns into a green arrow, click to open the Net 
Space window.

Double-click an icon to start the application.

After you finish using the software, click the S button in the upper 
right-hand corner to close the Net Space window.

24



Exploring the Walls

The VAIO Space walls help you organize and access the software on your 
Sony PC. Although you can see all three walls at the same time, only the 
center wall is active. To activate another wall, just click the wall.

Exploring the Walls

Wall
Video Wall 
A/V Wall

Application Wall

Description
Displays video clips.
Contains the Sony A/V Suite where you can play sounds, 
music, and videos. The A/V Wall also includes the 
integrated phone/fax application. See "Introducing the 
Sony A/V Suite" on page 37 for more information.
Provides a convenient way to launch your preinstalled 
software.

Launching Applications
The software that comes with your Sony PC is arranged into four 
categories on the Application Wall:

□ Work Center presents a variety of productivity tools including word 
processing and financial management applications.
Reference Library stores multimedia reference materials such as 
encyclopedias and dictionaries.
Game Arcade offers entertainment software titles.

□ Kid's Land includes software designed especially for children.

To launch software from the Application Wall

Click the Application Wall to move it to the center position.

□

□

1
2 Click the category you want to open: Work Center, Reference Library, 

Game Arcade, or Kid's Land.

3 Double-click the icon to start the software.

25



i Getting Started with VAIO Space

Adding and Removing Applications in VAIO Space
If you purchase additional software, you can add icons to VAIO Space so 
that you can easily launch these applications. You can add software to 
any of the following areas within VAIO Space:

□ Work Center
□ Reference Library
□ Game Arcade
□ Kid's Land
□ Net Space
□ My Space
□ MoreA/V

To add an application to VAIO Space

1 Install the application by following the installation instructions that 
come with the software.

2 Open the VAIO Space area where you want to add the application.

For example, to add a game to the Game Arcade, move the 
Application Wall to the center position, and click the Game 
Arcade category.

3 Click the Add Application button to display the Add Application 
dialog box.

Folder Icons

ADD APPLICATION

J ^ (Cl
_ J Aaoeiech
“ _J Fort* •

__I Plm

_1 PVjg_ri$
_I Sovep

Lt;___j captures
[♦ __ 1 Csftive

_J Dmi 
_J Hpfo
__i Manuals
__I Pfogram Files
.♦ ._J28.8DSVD Mode

Backup

Microsoft Money 
Calculator

1 «» 1 Notepad
Quicken SE Gateway 
WordPad1 UHOWCl

1 riST 1

. Applications 
that have 
already 
been added
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Exploring the Walls

4 Under Windows, change drives and folders, as necessary, to select 
the folder containing the application.

5 Select the icon for the software you want to add.

Note
^ You can launch the application to vcrifii your icot: selection by clicking the 

Test button.

6 In the Assign Name to Program dialog box, edit the file name to make 
it more descriptive if necessary.

ASSIGN NAME TO PROGRAM

NAHI OPAerUM.TOOO»AH

NM4I TO DISPIAY INCMrCOOnr USr

Rii..... ..... .......... .. ...  ~

r nOORAHIIEQUIMSCO-llOH

Note
^ If the software documentation indicates that you need to insert a CD each time 

you run the application, select the Program Requires CD-ROM check box.

7 Click the OK button to add the application.

8 Click the OK button to close the Add Application dialog box.

27



Il Getting Started with VAIO Space

To remove an application from VAIO Space 
Note

The foUoiriii;;; procedure only rcnioivf the application from VAIO Space. To remove 
the application and all its files from your hard disk, see the Introducing Microsoft 
Windows 95 guide or the Windows 95 online help.

Open the VAIO Space area containing the application you want 
to remove.

1

2

3

4
5
6

Click the Add Application button to display the Add Application 
dialog box.

Under VAIO Space, select the name of the application you want 
to remove.

Click the Remove button.

Click OK to remove the connection to VAIO Space.

Click the OK button to close the Add Application dialog box.

28



Exploring the Floor

Exploring the Floor
The icons on the VAIO Space Floor offer convenient access to common 
tasks, such as getting help and switching to the Window's 95 
environment. The icons are available for you to use when they are 
spinning. If the icons are not currently moving, you need to close any 
open windows to make the icons available.

Icon Description
Opens a window where you can store the software you use 
most often.

Runs the Welcome CD, where you can preview the applications 
preinstalled on your PC and learn about the technology your 
Sony PC has to offer.

Volcóme I

Lets you change your VAIO Space preferences.

Displays on-screen help for VAIO Space.

Switches to Windows 95, placing VAIO Space on the taskbar so 
that you can return to it easily.

Closes VAIO Space and switches to Window's 95.

29



Getting Started with VAIO Space

Using My Space
For quick access to the applications you use most often, place them in the 
My Space window. To add software to this window, see "Adding and 
Removing Applications in VAIO Space" on page 26.

To launch an application from My Space

1 Click the My Space icon to open the My Space window.

2 Double-click an icon to start an application.

3 After you finish using the software, click the Close button to close the 
My Space window.

Changing VAIO Space Settings
You can customize VAIO Space in a number of ways. For instance, you 
can choose a default environment, turn off sound effects, and select 
movies for the Video Wall.

VAIO SPACE SETTING

¥Mch Umt bvtertee vnuU you
fourtjrttem tooonwupwHh Wienyou tumHont

- VAIO SMce serrmo -
^ ButtanCfckSMmd

 ̂Mif Molto
K MootoSooml 

r VAIOlwdvtwndinoaB

Windowi(»95
Dosktop

r
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Exploring the Floor

To set your VAIO Space preferences

1
2

Click the Settings icon to open the VAIO Space Setting window. 

Change any of the following options.

Option
Which User Interface 
would you like your 
system to come up with 
when you turn it on?
Button Click Sound

Transition Sound 
Effect
Play Movie 
Movie Sound 
Movies button

VAIO background 
mode

Default Browser

Dial-Up Networking 
connection
Show 'Account Setup' 
window when you use 
Sony Online

Description
Choose VAIO Space or Windows 95 as your 
startup desktop.

Choose whether you hear a sound when you click 
the mouse.
Choose whether you hear a sound when you 
make a wall or the Sky active.
View movie clips on the Video Wall.
Turn the Video Wall movie soundtrack on or off. 
Add or remove movies. See "Selecting Movies for 
the Video Wall" on page 32.
Choose background mode when you want to 
use multiple VAIO Space applications at the 
same time.
Select the Internet browser to launch when you 
click the Sony Online icon.
Select the Internet Service Provider to use with 
Sony Online.
View or bypass the Account Setup window.

3 After you finish setting preferences, click the OK button.
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Getting Started with VAIO Space

Selecting Movies for the Video Wall
You can add MPEG movie files to the Video Wall and remove the 
default files.

To add movies

1 Click fhe Setfings icon on the Floor.

2 Click the Movies button.

3 Under Windows, select the icon for the movie you want to add. 

Note
^ Change lirhvs and folders, as uecessnr}/, to select the correct icon. Only MPG 

files appear in this uhtidow.

4 Click the Add button.

5 Click the OK button to close the Add Movie window.

To remove movies 
Caution

Removing movies deletes them from your hard disk drive.

1 Click the Settings icon on the Floor.

2 Click the Movies button.

3 Under VAIO Space, select the .MPG file you want to delete.

4 Click the Remove button.

5 Click the OK button to confirm thaf you want to delete the file.

6 Click the OK button to close the Add Movie window.
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Exploring the Floor

Using the Windows 95 Taskbar
The Windows 95 taskbar contains the Start button and buttons 
representing each open application and folder. It offers a quick and easy 
way to switch between open applications. By default, the taskbar appears 
at the bottom of the screen, but you can move it to any edge of the screen. 
While you are in VAIO Space, the taskbar is hidden but readily accessible.

To use the Windows 95 taskbar

1 Move the mouse pointer to the bottom of the screen to display the 
taskbar. The following shows a taskbar with several open 
applications.

%tili»v*IO Sp»” raMiiyi.«Ti^ ‘ iMTETBIStoWt^ I gjHllMlcPRO | 202PM

2 Do any of the following;

Action
Switch to another 
application 
Launch another 
application 
Move the taskbar

Note

Procedure
Click the application's button on the taskbar.

Click the Start button, point to Programs, and 
click the software title you want.
Click an empty part of the taskbar and then drag 
it to a different location. To display the taskbar 
after you move it, point to the edge of the screen 
where you placed the taskbar.

^ The taskbar disappears when you move the pointer away from it.
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Switching to Windows 95
VAIO Space and Windows 95 run simultaneously, and it's easy to switch 
back and forth between them. If you don't plan to use VAIO Space for an 
extended period of time, you can close it and work only in Windows 95.

To switch between Windows 95 and VAIO Space

1 Click the Windows icon on the Floor.

2 To return to VAIO Space, click the VAIO Space button on the taskbar. 

To close VAIO Space

1 Click the Exit icon to open the Exit VAIO Space dialog box.

2 Click the Close VAIO Space button to display the 
Windows 95 desktop.

To launch VAIO Space from Windows 95

1 Click the Start button to open the Start menu.

2 Click VAIO Space on the Start menu.
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Exploring the Floor

Shutting Down Your Sony PC
When you're ready to turn off your PC, use the following procedure. 

Caution
/l\ To iivoid the potential los^ of data, do not pre>^ the power fwiteh before you ahut 

down the PC.

To shut down your PC

1 Display the Windows 95 taskbar. See "Using the Windows 95 
Taskbar" on page 33.

2 Click the Start button to open the Start menu.

3 Click Shut Down at the bottom of fhe Start menu to display the Shut 
Down Windows dialog box.

Shul Down Windows

Ais you tue you wan) to;

<*■ ̂ hutdcwntfwcoiiieuliedi 
C gestartthecocnputei?
C Restart the computer in MS-DOS mode?
C £to»al programs and log on a$ adherent user?

b!es I No iirdp

4 Click Shut Down the Computer.

5 Click Yes.

Note
^ Respond to any prompts about saving documents.

6 Wait for your PC to turn off automatically.

7 Turn off fhe display and any of her peripherals conneefed to your PC.
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Introducing the Sony A/V Suite

The Sony A/V Suite provides an integrated suite of software that gives 
you complete control of the audio/video features of your Sony PC. The 
intuitive, "home stereo component" interface offers you a familiar set of 
sound and video controls.

You can access the Sony A/V Suite by clicking the A/V Wall in VAIO 
Space. You can also access the individual components from the Windows 
95 desktop by opening the Start menu, pointing to Sony Folder, pointing 
to A/V Suite, and then clicking the player you want to use.

:pi8iSBr
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Ml Introducing the Sony A/V Suite

The A/V Wall
In addition to including the Sony A/V Suite, the A/V Wall provides 
access to your phone and, through the More A/V button, access to 
additional A/V software titles. Each component is dedicated to a specific 
audio/video function.

Component
CD Player

WAV Player 

MIDI Player

Mixer

Video File Player 

Video CD Player

Description
Plays audio tracks from your CD-ROM drive.
See "Using the CD Player" on page 42.
Plays, records, and edits WAVE (.WAV) sound files.
See "Using the WAV Player” on page 49.
Plays, records, and edits MIDI (.MID) music files 
using external MIDI instruments. See "Using the MIDI 
Player" on page 62.
Controls the volume and tone levels for sound files, videos, 
audio tracks, and other devices. See "Using the Mixer" on 
page 40.
Plays AVI (.AVI) and MPEG (.MPG and .DAT) videos on 
your Sony PC screen. See "Using the Video File Player" on 
page 69.
Plays Video CDs. See "Using the Video CD Player" on 
page 74.
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Component
Phone

More A/V

The A/V Wall

Description
Launches the Phone application where you can use the 
built-in speakerphone, answering machine, and fax 
features. See the separate user guide for this application.
Lists additional software titles that come with your Sony 
PC. You can also use this area to add other A/V software 
for quick access. See "Using More A/V" on page 77.

The CD, WAV, MIDI, and Video File Players enable you to create 
playlists. Playlists let you save a selection of tracks or files you want to 
hear or view so that you can reuse them later.

Note
^ Some components nnd players in the A/V Suite have buttons with indicator lights. 

Them components are active when the light is on.
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Introducing the Sony A/V Suite

Using the Mixer
The Mixer enables you to control your Sony PC's sound sources for 
Windows multimedia and sound programs. The Mixer has individual 
contrcals for;

□ Master (all sources) playback and recording 
Note
^ Use the Master setting to override the individual settings for the other players 

and devices.

□

□
□
□
□

CD Player playback 
Note
^ If you add a CD-ROM drive with recording capabilities, use the CD recording 

setting to set, the input volume.

WAV Player playback and recording 
MIDI Player playback and recording 
Auxiliary device playback and recording 
Microphone input
MMER MMEren

i'i
m SI s Si

EòaQmo
gj“1 EJaux

LEVBL MPUrsaLEOT

WARNING
zis Do not use headphones the first time you use the Mixer. The default audio settings 

may be loud enough to cause hearing problems or discomfort when played through 
headphones. Listening to loud music with headphones or using headphones for an 
extended period of time may also cause hearing problems or discomfort.

Note
^ If you change an A/V player's volume setting, the Mixer display updates

automatically. Likewise, if you change the Mixer volume settings for an A/V player, 
the player's volume setting updates automatically.
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Using the Mixer

To change the Mixer volume setting

1 Click the Mixer on the A/V Wall.

2 Drag the slider(s) to set the volume for the selected sound source.
HMER MMLTER CO T M» ' MIX 1 Mc 1 "necoRO

M'ii'lIjiJi
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Drag the area between the 
sliders to move both sliders 
at the same time

Drag a slider to change only 
that slider

3 Repeat step 2 until you are satisfied with the resulting sound. 

Other Mixer Functions

Action
Toggle the sound on 
and off

Procedure
Click Q (Mute) for the specified source.
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Introducing the Sony A/V Suite

Using the CD Player
The CD Player plays regular audio CDs in your Sony PC's CD-ROM 
drive. It features the same type of functionality as an ordinary CD player 
(such as Next Track and Shuffle Play). You can also create playlists of 
your favorite songs for current and future listening sessions.

Mure L ft

SHUTFLC CdNTMie

^[M3 J »1 ■  I c=3

Playing an Audio CD
You can play an audio CD at any time, as long as you're not currently 
running a CD-ROM program. You can even close the CD Player window 
while listening to a CD. If the CD has a playlist, the player plays the 
selected tracks. For more information about playlists, see "Creating CD 
Playlists" on page 46.

To play an audio CD

1 Click the CD Player on the A/V Wall.

2 Click I ^ I (Eject) to open the CD tray.

3 Place an audio CD in the CD tray, and then click I A I (Eject) again 
to close the tray.

4 Click (Play).

The CD Player displays the track name and number, the CD name, 
the elapsed time, and a rotating CD that indicates the CD is playing.

AUDIO CO PLAYER
|pi-«iYi-ist| D I - I x I

SnUrrLC CONTNUe 

BBPeKT

Note
The CD and track names appear as "untitled" until you name them. (See 
"Naming a CD" on page 44 and "Naming CD Tracks" on page 45 for details.)
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other CD Player Functions

Action

Toggle the sound on and off
Stop play

Pause play

Go to the next track

Procedure

Click MUTE.

Click (Stop). 

Click (Pause). 

Click H (Next).
Go to the beginning of the 
current track

Click SWM.:1 (Previous).

Rewind the current track 

Fast forward the current track
Click and hold HWa (Rewind).

Click and hold HB (Fast Forward).
Play the tracks in random order Click SHUFFLE.
Adjust the volume Drag the CD volume sliders on the CD Playei 

or the Mixer. See "Using the Mixer" on 
page 40.

Create or update a playlist Click PLAYLIST. See "Creating CD Playlists' 
on page 46.

Play an intro to each track in 
the playlist

Click INTRO.

Play the current playlist tracks in 
the order in which they appear

Click CONTINUE.

Continuously play ("loop") the 
current playlist tracks in the 
order in which they appear

Click REPEAT.

Open or close the CD tray Click (Eject).

Note
^ To open the CD tray when you do not have a CD in the tray, press the Eject button

on the front panel of the PC. -
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Introducing the Sony A/V Suite

Naming a CD
Before you can create a playlist, you must name the CD. The CD Player 
stores this information and remembers it whenever you play the CD.

To name a CD

1 Click the CD Player on the A/V Wall.

2 Click the PLAYLIST button to display the CD Playlist Edit 
dialog box.

3 Click the Name CD button to display the Name CD dialog box.

CO Name: UNTITLED

OK

4
5

Type the name of the CD.

Click the OK button to save the CD name and return to the 
CD Playlist Edit dialog box.

The CD name now appears in the CD Name box.

Click the OK button to return to the CD Player.

The CD resumes playing and the name now appears in the 
CD Player display.
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Using the CD Player

Naming CD Tracks
After you name a CD, you can name the tracks on it as well. The CD 
Player stores this information and remembers it whenever you play 
the CD.

To name tracks on a CD

1 Click the CD Player on the A/V Wall.

2 Click the PLAYLIST button to display the CD Playlist Edit 
dialog box.

3 Click the Name Track button to display the Name Track 
dialog box.

Tf«ckN«me; 

Track Salact

I,.—.I L

4 Type the name of the track.

5 Click the Next button to name the next (or another) track.

Repeat this step for other tracks you want to name.

6 Click the.OK button to save the track name(s) and return to the 
CD Playlist Edit dialog box.

The track names now appear in the CD Tracks list.

Note
^ If you have a playlist for this CD, the track names also appear in the Playlist.

7 Click the OK button to return to the CD Player.

The CD resumes playing and the current track name now appears in 
the CD Player.

45



Introducing the Sony A/V Suite

Creating CD Playlists
After you name a CD, you can create a playlist ot the tracks you want to 
play. You can customize the list to include only your favorite tracks or all 
tracks on the CD. The CD Player stores this information and remembers it 
whenever you play the CD.

Note
^ Ifi/ou create a playlist without first naming the CD, the CD Player does not save 

the playlist.

To create and customize a CD playlist

1 Click the CD Player on the A/V Wall.

2 Click the PLAYLIST button to display the CD Playlist Edit 
dialog box.

. LO Ploy!.dll Pl.jyl.d IcH iMAIilAH CAfU Y MUSIL PIIXI
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Total TfBoka TotdTIm

OK m ’
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Using the CD Player

Select the tracks you want to add to the playlist:

Procedure
Double-click the track, or select the track and then

Action
Copy one track in the 
Names list to the playlist
Copy all tracks in the 
Names list to the playlist
Copy a range of tracks 
in the Names list to the 
playlist
Copy selected tracks in 
the Names list to the 
playlist

click [ 
Click

(Add Selection). 

1 (Add All Files).

Press the SHIFT key on the keyboard while 
clicking the first and last tracks in the range, and 
then click I B | (Add Selection).
Press the CTRL key on the keyboard while 
clicking each track, and then click h <1 I (Add 
Selection).

4 Ctirk the OK button to save the playlist.

Note
You can add CD trucks to a plai/list In/ opening the pluylist and selecting the 
tracks you want to add as described in step 3.
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Introducing the Sony A/V Suite

Removing Tracks from a CD Playlist
If you don't want to listen to specific tracks on a CD, you can remove 
them from the playlist.

To remove a track from a CD playlist

1 Click the CD Player on the A/V Wall.

2

3

Click the PLAYLIST button to display the CD Playlist Edit 
dialog box.

Select the tracks you want to remove from the playlist:

Action
Remove one track from 
the playlist

Remove all tracks from 
the playlist

Procedure
Click the track, and then click | jta | 
(Delete Selection).

Click I Jt^l (Delete All Selections).

4

5

Click I H I (Save File), and then type a new file name or select the 
name of the current playlist.

Click the OK button to save the file.

Note
^ If you selected the name of the current playlist, click the Yes button in the next 

dialog box, luhich asks whether you want to overwrite the file.
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Using the WAV Player

Using the WAV Player
The WAV Player lets you record and play WAV sounds (such as 
keyboard clicks and your own voice). You can make playlists of your 
favorite sounds to play during current and future listening sessions. You 
can also use the WAV Player to edit sounds. See "Using AudioView" on 
page 55 for details.

Playings WAV File
You can open and play individual WAV files, or you can create a list of 
specific WAV files to play.

To play a WAV file

1 Click the WAV Player on the A/V Wall.

2 Click PLAYLIST to display the WAV Playlist dialog box.

fhc --------------

iams
L±±j

aiarm
c«wa.wav
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3 Select a WAV file from the Name list, and then click the OK button.

4 Click I > I (Play) to hear the sound.
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Other WAV Player Functions

Action
Toggle the sound on 
and off 
Stop play 
Pause play
Create or update 
a playlist
Go to the next file in 
the playlist
Go to the beginning 
of the current file in 
the playlist
Rewind the current file

Fast forward the 
current file
Play the playlist files in 
random order 
Adjust the volume

Play an intro to each file 
in the playlist
Play the current playlist 
files in the order in which 
they appear
Continuously play 
("loop") the current 
playlist files in the order 
in which they appear
Record a WAV sound 

Edit a WAV sound

Procedure
Click MUTE.

Click 0 (Stop). 

Click (Pause).
Click PLAYLIST. See 
page 51.
Click I I (Next).

'Creating WAV Playlists" on

Click I U (Previous).

Click and hold ! 

Click and hold

(Rewind).
(Fast Forward).

Click SHUFFLE.

Drag the WAV volume sliders on the WAV Player or 
the Mixer. See "Using the Mixer" on page 40.
Click INTRO.

Click CONTINUE.

Click REPEAT.

Click I ♦  I (Record). See "Recording a WAV File" 
page 61.
Click AUDIOVIEW to launch AudioView. See 
"Editing a WAV File" on page 55.
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Using the WAV Player

Creating WAV Playlists
You can create or customize a playlist of the WAV files you want to play 
(such as animal sounds or funny noises). You can add files one at a time, 
or you can add a group of files.

To create and customize a WAV playlist

1 Click the WAV Player on the A/V Wall.

2 Click the PLAYLIST button to display the WAV Playlist dialog box.
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Introducing the Sony A/V Suite

3 Select the WAV files you want to add to the playlist, changing drives 
and folders as necessary:

Action
Copy one file in the 
Names list to the playlist
Copy all files in the 
Names list to the playlist 
Copy a range of files in 
the Names list to the 
playlist
Copy selected files in the 
Names list to the playlist

Find all WAV files on the 
selected drive

Note

Procedure
Double-click the file, or select the file and then 
click I B I (Add Selection).

Click (Add All Files).

Press the SHIFT key on the keyboard while 
clicking the first and last files in the range, and 
then click I B | (Add Selection).
Press the CTRL key on the keyboard while 
clicking each file, and then click | g |
(Add Selection).

Click (Search Selected Drive).

^ To play a sound file, select the file, and then click \ >■  | (Play). To play the files 
you select automatically, click Q (Automatically Play Highlighted File).

4 Click I (Save File), and then type a file name.

Note
^ Change drives and folders, as necessary, to save the file to the correct location. 

The sound playlist file extension defaults automatically to VSL.

5 Click the OK button to save the file.

Note
^ You can add WAV files to a playlist by opening the playlist and selecting the 

files you want to add. To remove files from a playlist, see "Removing Files from 
a WAV Playlist" on page 54.
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Using the WAV Player

Playing a WAV Playlist
If you have more than one WAV playlist, you must select which list you 
want to play. If you have only one playlist, just click | » | (Play) on the 
WAV Player.

To play a WAV playlist

1 Click the WAV Player on the A/V Wall.

2 Click the PLAYLIST button to display the WAV Playlist dialog box.

3 Click L I (Open File), and then select the file you want to open. 

Note
^ Change drives and folders, as necessary, to select a file.

4 Click The OK button to open the file and return to the WAV Playlist 
dialog box.

5 Click the OK button to return to the WAV Player.

6 Click I ►  I (Play) to hear the sounds in the playlist.
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Removing Files from a WAV Playlist
If you don't want to hear specific files in a WAV playlist, you can remove 
them from the list.

To remove files from a WAV playlist

1 Click the WAV Player on the A/V Wall.

2
3

Click the PLAYLIST button to display the WAV Playlist dialog box. 

Select the WAV files you want to remove from the playlist:

Action Procedure
Remove one file from 
the playlist

Remove all files from 
the playlist

Select the file, and then click 
(Delete Selection).

Click MBaiii (Delete All Selections).

4

5

Click I g I (Save File), and then type a new file name or select the 
name of the current playlist.

Click the OK button to save the file.

Note
^ If you selected the name of the current playlist, click the Yes button in the next 

dialog box, which asks whether you want to overwrite the file.
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Using AuciioView^'^
AudioView enables you to edit WAV sounds using common editing 
functions, such as cut, copy, and paste. Other editing functions include 
sound mixing and changing playback volumes. You can record and edit 
new WAV sounds as well.

Editing a WAV File
You can edit a WAV file to remove dead (flat) spots and to rearrange 
and mix sounds. Most editing requires selecting start and end points of a 
segment or range that you want to change.

Note
^ If you choose AUDIOVIEW ivhen a WAV file is already open, the current WAV 

file appears.

To cut and paste data

1 Click the WAV Player on the A/V Wall.

2 Click the AUDIOVIEW button to display AudioView.

3 If necessary, open the File menu and select Open to display the file 
you want to edit.
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4 Click I > I (Play) to hear the sound.

!^AudioView StNKDR WAV
£1b £dl Xiartrforn« Qpbora ̂ ndowc

I-Ml a I ►  I » I II I ►>• I ̂  B
r |g^' |b 1^11 liMlgBl ji \ Q I1661

5 Select the segment you want to cut. See "Segment Selection 
Functions" below for details.

Segment Selection Functions

Action
Select a segment

Select the entire file

Select a segment as
1 you listen

>

1'
Make rough adjustments 
to the selected segment
Make precise 
adjustments to the 
selected segment

Procedure
Click the Start point in the graphic display, drag the 
mouse to the right to the desired End point, and then 
release.
Double-click anywhere in the graphics display, or 
open the Edit menu and select Select All.

Play the file. When you hear the sound you want to 
use as the Start Point, hold down the (Select 
Range During Playback) as the passage plays. Release 
the button at the end of the desired segment, and then 
click 1*1 (Stop).
Hold down the SHIFT key on the keyboard, place the 
mouse cursor at the desired location and then click.
Click anywhere on the Range Start or Range End 
areas (to the left and right of I****I, respectively).
Then click the up or down arrow to adjust the time 
by 1/100th second.
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Note
^ After you select the segment, the displai/ highlights the segment. Note the 

numbers in the Rtinge Start and Range End marker boxes. These numbers can 
help’ you select the same segment again.

For example, to select this segment

End Point:
Drag the mouse to here, 
then release.

6 Click nr (Cut).

Note
^ If you want to paste the data into another WAV file, open that file now.

7 If you want to move the segment, click the location where you want 
to paste the data, and then click (Paste).

8 Click I '» I (Play) to hear the edited sound.

9 When you're ready to save the new sound, open the File menu and 
select Save A s . . a n d  then type a file name.

Note
^ Change drives and folders, as necessary, to save the file to the correct location.

10 Click the OK button to save the file.
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To copy and paste data

1 Click the WAV Player on the A/V Wall.

2 Click the AUDIOVIEW button to display AudioView.

3 If necessary, open the File menu and select Open to display the file 
you want to edit.

AudmVtcw StNKOn WAV
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4 Click I *■  I (Play) to hear the sound.

5 Select the segment you want to copy, and then click (Copy). See 
"Segment Selection Functions" on page 56 for details.

The display highlights the selected segment.

Note
^ If you want to paste the data into another WAV file, open that file now.

6 If you want to move the segment, click the location where you want 
to paste the data, and then click (Paste).

7 Click I >- I (Play) to hear the edited sound.

8 When you're ready to save the new sound, open the File menu and 
select Save As..., and then type a file name.

Note
Change drives and folders, as necessary, to save the file to the correct location.

9 Click the OK button to save the file.
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Other AudioView Edit Functions

Action
Stop play 

Pause play
Rewind the current sound 

Fast forward the current sound 

Adjust the volume

Select a segment or range

Play the selected segment

Delete all data except a
selected segment
Adjust the volume (amplitude)
of a selected segment
Echo a selected segment

Remove background noise

Adjust the volume (amplitude) 
and improve the signal-to-noise 
ratio of a sound recorded at too 
low a level
Fade in or fade out a 
selected segment
Undo the last edit or 
transform operation 
Zoom in on a selected segment 

Zoom out of a selected segment

Procedure

Click (Stop).

Click (Pause).
Click and hold | | (Rewind).

Click and hold | »■  j (Fast Forward).
Drag the WAV volume sliders on the WAV 
Player or the Mixer. See "Using the Mixer" 
on page 40.
See "Segment Selection Functions" on 
page 56.
Click ll»*! (Play Range).

Click |xyj (Trim).

Click |qp| (Scale).

Click [5S1 (Echo).

Click I wj (Noise Gate) to find every sample 
in the selected segment with an amplitude 
below a specific amount.

Click IWl) (Normalize).

Click U. (Fade).

Click (Undo).

Click I 

Click 1

(Zoom In). 

(Zoom Out).
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Other AudioView Functions—Edit and Transforms Menus

Procedure
Open the Edit menu and select Insert Silence. 
Open the Edit menu and select Load File into 
Clipboard.
Open the Edit menu and select Save 
Clipboard, and then specify the file name. 
Copy or cut a segment, select a segment in 
the file you want to mix, and then open the 
Edit menu and select Mix Paste.
Open the Transforms menu and select 
Find Peak.

Open the Transforms menu and select 
Invert Samples.
Open the Transforms menu and select 
DC Offset.

Action
Insert silence (dead or flat spot)
Copy a file to the Clipboard

Save contents of the Clipboard 
to a file
Combine (mix) two sounds by 
copying one sound mvr the other

Locate and display the highest 
volume level (amplitude) within 
a selected segment 
Change positive amplitude 
values to negative, and vice versa 
Center the display for a sound 
recorded with an offset or adjust 
the offsets of a file after cutting 
and pasting data from different 
files
Paste a selected segment 
backwards
Fade out the current file, fade in 
the data currently in the Clipboard, 
and then combine the sounds 
Reduce a sound's sample rate by 
50 percent
Convert a 16-bit file to 8-bit 
format
Change a stereo file into a 
mono file
Convert an 8-bit PCM WAV file 
to Sound Blaster® VOC format 
Convert a VOC file to 8-bit PCM 
WAV format 
Change the sample rate

Note
^ For additional information about how to use these functions, see the online help.

Open the Transforms menu and select 
Reverse.
Open the Transforms menu and select 
Crossfade.

Open the Transforms menu and select 
Halve Sample Rate.
Open the Transforms menu and select 
16 8 Bits.
Open the Transforms menu and select 
Stereo -*■  Mono.
Open the Transforms menu and select 
WAV VOC.
Open the Transforms menu and select 
VOC - WAV.
Open the Tranforms menu and select 
Change Speed.
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Recording a WAV File
You can make WAV recordings easily using the WAV Player or 
AudioView.

1 Select an input source (such as Mic or CD) in the Mixer and set its 
record volume level. See "Using the Mixer" on page 40 for details.

2 If you want to record from fhe CD-ROM drive or from an external 
source (such as a tape deck), find the selection you want to record.

3 Click (Record) on the WAV Player or AudioView display.
The red light blinks, indicating that the player is in Record 
Standby mode.

4 Click I > I (Play) to begin recording. Speak into the microphone or 
start paying the material you prepared in step 2.

5 If necessary, click (Pause) to pause temporarily during recording. 
Click (Pause) again to resume recording.

Note
^ Be sure to use the \ » | (Pause) button to resume recording. If you click | ♦  | 

(Record)to resume recording, ifou erase the existing recording and start a 
new one.

6
7

8

Click (Stop) after you finish recording.

If you are using AudioView to record, the display shows a graphical 
representation of the recording.

Click I » I (Play) to hear the recording.

Note
^ You can repeat steps 2 through 8 until you are ready to save the recording.

9 When you're ready to save thg recording, open the File menu and 
select Save, and then type a file name.

Note
^ Change drives and folders, as necessary, to save the file to the correct location. 

If you don't want to save the recording, record over it or close the file.

10 Click the OK button to save the file.
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Using the MIDI Player
The MIDI Player plays and records standard MIDI (.MID) music files. 
You can also make playlists of your favorite music to play during current 
and future listening sessions.

Mure i m ^^iiiiii^^iimii^mi^^iiigiiii^yniiiiii^ IMTAO ' fVEPCSWT*

The MIDI player also includes the MIDI Orchestrator, a tool that enables 
you to record and play as many as 16 tracks. You can access the MIDI 
Orchestrator by clicking the MIDI ORCH button on the MIDI Player. For 
more information about using the MIDI Orchestrator, see the online help.

Playing a MIDI File
You can open and play individual MIDI files, or you can create a list of 
specific MIDI files to play.

To play a MIDI file

1
2

Click the MIDI Player on the A/V Wall.

Click PLAYLIST to display the MIDI Playlist dialog box.

groove, rnd
itlandmid i
ft«hop.md 1
koolhin mid 1
kt2t2.md 1tetenrly.tnd I
tanbna3.(rad 1«tecceto mid
tuknhmid
wakzflimid __B

^MIEPlrit«d)

i*

3 Select a MIDI file from the Name list, and then click the OK button.

4 Click |-> I (Play) to hear the music.
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Other MIDI Player Functions 

Action
Mute the sound 
Stop play 

Pause play

Create or update a playlist

Go to the next file in the playlist

Go to the beginning of the current 
file in the playlist 
Rewind the current file 

Fast forward the current file

Play the playlist files in 
random order 
Adjust the volume

Play an intro to each file in 
the playlist
Play the current playlist files in the 
order in which they appear
Continuously play ("loop") the 
current playlist files in the order in 
which they appear 
Record a MIDI music file

Procedure
Click MUTE.
Click (Stop).

Click (Pause).
Click PLAYLIST. See "Creating MIDI 
Playlists" on page 64.

Click I »X 1 (Next).
Click I HW I (Previous).

(Rewind).Click and hold G

Click and hold D 
(Fast Forward). 
Click SHUFFLE.

Drag the MIDI volume sliders on the MIDI 
Player or the Mixer. See "Using the Mixer" 
on page 40.
Click INTRO.

Click CONTINUE.

Click REPEAT.

Click I • I (Record). See "Recording a MIDI 
File" on page 68.
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Creating MIDI Playlists
You can create or customize a playlist of the MIDI files you wanf to play 
(such as files of an individual composer or files from your own recording 
sessions). You can add files one at a time, or you can add a group of files.

To create and customize a MIDI playlist

1 Click the MIDI Player on the A/V Wall.

2 Click the PLAYLIST button to display the MIDI Playlist dialog box.

(^ireciOQC

groove fn»j 
island, md 

tfshop.mid 

koo*hin.mid 

Ii$zt2 mid 
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Note
,¿3) To play a music file, select the file, and then click |

you select automatically, click Q (Automatically Play Highlighted File).
(Play). To play the files
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3 Select the MIDI files you want to add to the playlist, changing drives 
and folders, as necessary:

Action
Copy one file in the 
Names list to the playlist
Copy all files in the 
Names list to the playlist 
Copy a range of files 
in the Names list to the 
playlist
Copy selected file in the 
Names list to the playlist

Find all MIDI files on 
the selected drive

Procedure
Double-click the file, or select the file, and then 
click I B I (Add Selection).

Click iBtel (Add All Files).

Press the SHIFT key on the keyboard while 
clicking the first and last files in the range, and 
then click I B | (Add Selection).
Press the CTRL key on the keyboard while 
clicking each file, and then click f B I 
(Add Selection).

Click 151 (Search Selected Drive).

4 Click I B I (Save File), and then type a file name.

Note
^ Change drives and folders, as necessary, to save the file to the correct location. 

The MIDI playlist file extension defaults automatically to VML.

5 Click the OK button to save the file.

Note
^ You can add MIDI files to a playlist by opening the playlist and selecting the 

files you want to add. To remove files from a playlist, see "Removing Files from 
a MIDI Playlist" on page 67.
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Playing a MIDI Playlist
If you have more than one MIDI playlist, you must select which list you 
want to play. If you have only one playlist, just click | >■  | (Play) on the 
MIDI Player.

To play a MIDI playlist

1 Click the MIDI Player on the A/V Wall.

2 Click the PLAYLIST button to display the MIDI Playlist dialog box.

3 Click I ig I (Open File), and then select the file you want to open. 

Note
 ̂Change drives and folders, as necessary, to select a file.

4 Click the OK button to open the file and refurn to the MIDI Playlist 
dialog box.

5 Click the OK button to return to the MIDI Player.

6 Click I »■  I (Play) to hear the music in the playlist.
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Removing Files from a MIDI Playlist
If you don't want to hear specific files in a MIDI playlist, you can remove 
them from the list.

To remove files from a MIDI playlist

1
2
3

Click the MIDI Player on the A/V Wall.

Click the PLAYLIST button to display the MIDI Playlist dialog box. 

Select the MIDI files you want to remove from the playlist:

Action Procedure
Remove one file from 
the playlist
Remove all files from 
the playlist

Select the file, and then click | |
(Delete Selection).
Click (Delete All Selections).

4

5

Click i'dd ' i (Save File), and then type a new file name or select the 
name of the current playlist.

Click the OK button to save the file.

Note
^ If you selected the name of the current playlist, click the Yes button in the next 

dialog box, which asks whether you want to overwrite the file.

67



Introducing the Sony A/V Suite

Recording a MIDI File
You can make MIDI recordings easily using the MIDI Player and 
a MIDI instrument. Before you record a MIDI file, you musf connect a 
MIDI instrument to the MIDI interface connector on the back panel 
of your Sony PC (see "Connecting a Joystick or MIDI Instrument" on 
page 14).

1 Click the MIDI Player on the A/V Wall.

2 Click (Record). The red light blinks, indicating that the MIDI 
Player is in Record Standby mode.

3 Click (Play) to begin recording, and then start playing the MIDI

5
6

instrument.

If necessary, click (Pause) to pause temporarily during recording. 
Click (Pause) again to resume recording.

Note
Be sure to use the \ » | (Pause) button to resume recording. If you click \ * | 
(Record) to resume recording, you erase the existing recording and start a 
new one.

After you finish recording, click (Stop).

Click I (Play) to hear the recording.

Note
^ You can repeat steps 1 through 6 until you arc ready to save the recording.

7 When you're ready to save the recording, open the file menu and 
selecf Save, and then type a file name.

Note
A Change drives and folders, as necessary, to save the file to the correct location. If 

you don't want to save the recording, record over it or close the file.

8 Click the OK button to save the file.
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Using the Video File Player
The Video File Player plays AVI (.AVI) and MPEG (.MPG and .DAT) 
videos on your Sony PC. You can use it to make playlists of your favorite 
videos to play during current and future viewing sessions. You can view 
playlists in a small window or in a full screen as a screen saver.

IKTWJ nsPCAT

Creating Video Playlists
You can create a playlist of your favorite video files or of specific types 
of video files (such as movie clips or software demos).

To create and customize a video playlist

1 Click the Video File Player on the A/V Wall.

2 Click the PLAYLIST button to display the Video Playlist dialog box.

ml

CLOSEWIN.AVI
ORAGDROP.AVI
EXPLORER.AV!
FIND.AVI
MOVEWIN.AVI
PASTE.AVI
SCR0LL.AV1
SIZEWIN.AVI
SPLASH.AVI
TASKSWCH.AVI

■ XiPa:■
-J All Video files

I I B

I I a*
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3 Select the video files you want to add to the playlist, changing drives 
and folders, as necessarv:

Action
Copy one file in the 
Names list to the playlist
Copy all files in the 
Names list to the playlist
Copy a range of files in 
the Names list to the 
playlist
Copy selected files in the 
Names list to the playlist

Find all video files on 
the selected drive

Procedure
Double-click the file, or select the file and then 
click

Click
B I (Add Selection). 

[№ (Add All Files).

Press the SHIFT key on the keyboard while 
clicking the first and last files in the range, and 
then click I <1 I (Add Selection).
Press the CTRL key on the keyboard while 
clicking each file, and then click f tp |
(Add Selection).
Click Id] (Search Selected Drive).

I (Save File), and then type a file name.4 Click []

Note
Change drives and folders, as necessary, to save the file to the correct location. 
The video playlist file extension defaults automatically to VVL.

5 Click the OK button to save the file.

Note
^ You can add video files to a playlist by opening the playlist and selecting the 

files you want to add. To remove files from a playlist, see "Removing Files from 
a Video Playlist" on page 73.
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Other Video File Player Functions 

Action
Change between full-screen, auto­
size, and user-size mode
Stop full-screen play 
Mute the sound 
Stop play 

Pause play

Go to the next video in the playlist

Go to the beginning of the current 
video in the playlist 
Rewind the current video 

Fast forward the current video

Play the playlist videos in 
random order 
Adjust the volume

Play an intro to each file in 
the playlist
Play the current playlist files in the 
order in which they appear
Continuously play ("loop") the 
current playlist files in the order in 
which they appear '

Procedure
Click SCREEN.

Click anywhere on the screen. 
Click MUTE.

Click (Stop).
Click I n I (Pause).

Click I I (Next).

Click I 1« I (Previous).

Click and hold I ■ »< I (Rewind).
Click and hold I »» 1 (Fast Forward). 
Click SHUFFLE.

Drag the volume sliders on the Video 
File Player.
Click INTRO.

Click CONTINUE.

Click REPEAT.
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Playing a Video Playlist
If you have more than one Video playlist, you must select which list 
you want to play. If you have only one playlist, just click |^»■  | (Play) on 
the Video File Player.

To play a video playlist

1 Click the Video File Player on the A/V Wall.

2 Click the PLAYLIST button to display the Video Playlist dialog box.

3 Click I tSf I (Open File), and then select the file you want to open. 

Note
^ Cha nge drives and folders, as necessary, to select a file.

4 Click the OK button to open the file and return to the Video Playlist 
dialog box.

5 Click the OK button to return to the Video File Player.

6 Click I » i (Play) to begin viewing the videos in the selected playlist.
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Removing Files from a Video Playlist
If you don't want to view specific files in a Video playlist, you can remove 
them from the list.

To remove files from a video playlist

1
2
3

Click the Video File Player on the A/V Wall.

Click the PLAYLIST button to display the Video Playlist dialog box. 

Select the video files you want to remove from the playlist:

Action Procedure
Remove one file from Select the file, and then click j | 
the playlist (Delete Selection).
Remove all files from Click (Delete All Selections), 
the playlist

4

5

Click I B I (Save File), and then type a new file name or select the 
name of the current playlist.

Click the OK button to save the file.

Note
^ If you selected the name of the current playlist, click the Yes button in the next 

dialog box, which asks whether you want to overwrite the file.
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Using the Video CD Player
The Video CD Player plays CDs in the Video CD format, such as Karaoke 
and enhanced CDs.

To play a Video CD

1 Click the Video CD Player on the A/V Wall to display the Video CD 
Player and the viewing screen.

VOEX) CO PLAYER

VOLUME REPEAT

I.
I..■ *«.... II........... >». I

Q (D 
0 ® ® 
0 (i) 0 
0 00

2
3
4
5

Click I I (Eject) to open the CD tray.

Place a Video CD in the CD tray.

Gently push the CD tray to close it.

Click the LOAD button to play the video.

Note
^ Video CDs that include a player will play automatically.

If the video is interactive and asks you to make a choice, click 
a number on the Video CD Player numeric keypad to make 
your selection.
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Other Video CD Player Functions

Action
Select an option on the 
video screen

Control an interactive sequence 
(selection function)
Mute the sound
Stop play

Fast forward the current track

Increase the volume
Reduce the volume
Return to a previous 
interactive menu

Procedure
Click the numbered button that corre^onds 
to your selection (for example, click ^ I 
select 1).
Click pn (Play)^ ^

to

Pause play
Resume play when the video 
is paused
Go to the next track (interactive 
CDs only)
Go to the beginning of the current 
track (interactive CDs only) 
Rewind the current track

Click MUTE,
(Stop). 
(Pause).

Click I 
Click!
Click (Play).

Click (Next).

Click lltifl (Previous).

(Rewind).Click and hold [
Click and hold I >* t 
(Fast Forward).
Click I' ■ » 1 (Volume Up).
Click [«*•' ! (Volume Down). 
Click @ (Return).

Continuously play the Video CD Click REPEAT.
Change the resolution for 
interactive video still pictures
Play the Video CD at 
approximately double speed
Specify the output mode 

Specify the audio quality

Click SCREEN to toggle between HiRes (high 
resolution) and LoRes (low resolution).
Click SEARCH.

Click CONFIGURE, and then click Mono 
or Stereo.
Click CONFIGURE, and then select AM, FM, 
or CD in the Quality list.
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Action
Enable Karaoke mode for video 
CDs with Karaoke content
Enable or disable the audio

Adjust the initial size of the 
video window 
Adjust the display rate

Enable or disable synchronized 
video playback
Enable or disable the video

Reset the configuration defaults

Change the CPU resources 
dedicated to running the video
Specify the audio mode

List information about the CD 
Open or close the CD tray

Notes

Procedure
Click CONFIGURE, and then select the 
Karaoke check box.
Click CONFIGURE, and then, under Audio, 
select the Disabled check box.
Click CONFIGURE, and then select the 
appropriate option from the Open Size list.
Click CONFIGURE, and then select the 
appropriate option from the Display list.
Click CONFIGURE, and then select the 
Synchronized Playback check box.
Click CONFIGURE, and then, under Video, 
select the Disabled check box.
Click CONFIGURE, and then dick the 
Default button.
Click CONFIGURE, and then drag the scroll 
box in the CPU area.
Click AUDIO until the mode you want 
appears in the video window (Mono, Stereo, 
Left, or Right).
Click CD INFO.

Click (Eject).

 ̂Click the OK button to sni’c any configuration changes you make in the 
Configuration window.

For additional information about how to use these functions, see the online help.
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Using More A/V
More A/V displays additional software titles that came with your Sony 
PC. You can add your own audio/video titles for quick access. For 
information on adding software to the More A/V area, see “Adding and 
Removing Applications in VAIO Space" on page 26.

To run a program from More AN

1 Click More A/V on the A/V Wall.

2 Double-click the application you want to run.
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Getting' Help

Sony provides several support options for your Sony PC. When you have
questions about your PC and the preinstalled software, check these places
for answers:

□ This guide explains how to set up and upgrade your computer, use 
VAIO Space and the A/V Suite software, and perform basic 
computer tasks.

□ The online System Reference Manual provides detailed information 
about the hardware in your Sony PC, as well as how to setup and 
upgrade your system. You can access the online System Reference 
ManilOt hom the Start menu.

□ The other manuals and online help files fhat may accompany your 
preinstalled software contain instructions on using these titles. Some 
applications include a printed manual, but most of the manuals are 
located on your hard disk drive as online help files. You can access 
the online help files from the Sony Folder on the Start menu or from 
the Help menu in the specific application.

□ The About Your Sony PC guide lists the telephone support numbers 
for your preinsfalled software titles. This guide also includes a 
packing list and technical specifications for your Sony PC.

□ The Sony Sales and Marketing Support number offers information 
about your Sony PC and other Sony products that work with
your PC. To contact Sony Sales and Marketing Support, call 
1-888-4SONYPC (1-888-476-6972). ■

□ The Sony Fax-back service provides you with answers to commonly 
asked questions. You can use this automated service to request a list 
of available topics and then select the topics that you want to receive. 
To contact the Sony Fax-back service, call 1-888-4SONYPC 
(1-888-476-6972).

□ The Sony e-mail support service answers your questions by 
electronic mail. Just send your question in an e-mail message, and a 
Customer Service Representative will send you a reply with the 
answer. To send a question to Sony e-mail support, address the 
message to SOS@info.sel.sony.com.
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The SOS software connects you to a Customer Support 
Representative. SOS is available toll-free 24 hours a day, seven 
days a week. You can contact SOS by telephone or by using your 
built-in modem. Be sure to connect your modem before you call, 
so that the representative can access your system if necessary. For 
information on calling SOS with your built-in modem, see the next 
section, "Calling SOS." To call SOS using your telephone, dial 
1-888-4SONYPC (1-888-476-6972).

Calling SOS
The SOS application enables you to exchange information with a Sony 
Customer Support Representative (CSR). Using the built-in 
speakerphone is the most convenient way to contact SOS. Here's 
how it works:

□ Type your name and a description of the problem in the SOS window
□ Dial the SOS hotline with a single click of the mouse
□ Specify the access level for the CSR
□ The CSR resolves the problem
Before using SOS, make sure the PC is connected to a phone line as 
described in "Connecting the Phone Line and Phone" on page 11. If you 
do not have a phone line connected to your PC, you can call SOS by 
dialing 1-888-4SONYPC (1-888-476-6972).

Note
If you call SOS using the speakerphone and you need to reboot your PC, you will lose 
your connection to SOS. For this reason, it is recommended that you connect a 
regular telephone to the Sony PC as described in "Connecting the Phone Line and 
Phone" on page 11. You can then take the receiver off the hook to maintain the 
connection while you reboot the PC.

80



Calling SOS

To place a call to SOS

1 Click the SOS icon in the VAIO Space Sky, or select SOS from the 
Sony Folder on the Start menu.

ProMm DMCi^on
•S'OS'

2 In the SOS window, type your name, phone number, and a 
description of the problem.

3 Call SOS:

□ If you are using the built-in speakerphone, click the Call SOS 
button.,

□ If you are using a regular telephone that you connected to your 
PC, remove the phone from thé receiver, and then click the Call 
SOS button.
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4 When the Remote Command Security dialog box appears, select an 
access level by clicking one of these options:

Option
Full access

Limited access

No access

Description
Allows the CSR to fully interact with your PC. The CSR 
can access all the files on your hard disk drive and can 
copy files to and from your PC to solve your problem. 
Lets the CSR view your system, but you must approve 
every action the CSR takes. If the CSR wants to copy a 
file, for example, the Remote Command Permission 
dialog box prompts you to approve this action.
Prevents the CSR from accessing your system. You 
must perform all the operations as described to you by 
the CSR.

Note
 ̂Yon can change the access level during your call to SOS.

Discuss the problem with the CSR and follow the CSR's instructions 
to resolve the problem.

Notes
^ Yoii may hear beeps on the line as the system szuitches between voice and data 

modes. You can ignore these beeps.

When a file is being transmitted between your PC and SOS, a status box 
displays the progress of the file transfer.

To end a call placed with the speakerphone, click the SpeakerPhone 
button. Otherwise, just hang up the phone when you finish a call.

Click the Close box at the top right corner of the SOS window or 
select Exit from the File menu to close the SOS window.
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Troubleshooting
This section describes how to solve common problems you may 
encounter when using your PC. Many problems have simple solutions, so 
try these suggestions before you call Sony Online Support. For more 
advanced troubleshooting information, see the online System Reference 
Manual.

My PC won't start
□ Check that the PC is plugged into a power source and that it is turned 

on. Check that the power light is lit on the front panel of the PC.
□ Make sure a diskette is not in the diskette drive.
□ Confirm that the power cord and all cables are connected firmly, as 

described in the "Setting Up Your Sony PC" chapter.
□ If you plugged the PC into a power strip or UPS, make sure the 

power strip or UPS is turned on and working.
□ Check that the display is plugged into a power source and turned on. 

Check that the brightness and contrast controls are adjusted correctly. 
See the manual that came with your display for details.

My PC "locks up"
□ Try restarting the PC. On the Windows taskbar, click the Start button, 

click Shut Down, and then click Restart the computer.
□ If you cannot restart as described in the preceding step, you can 

restart the PC by pressing CTRL+ALT+DELETE.
Caution
As. Pressing CTRL+ ALT+DELETE may result in losing changes made to files that 

are currently open.

My CD-ROM drive tray won't open
□ Make sure the PC is turned on.
□ Press the Eject button on the CD-ROM drive.
□ If the Eject button does not work, you can open the CD tray by 

inserting a straightened heavy-weight paper clip into the hole beside 
the Eject button.
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I cannot play a CD-ROM disc
□ Make sure you place the disc in the tray with the label side facing up.
-J Make sure the CD-ROM software is installed according to the 

program's instructions.

I installed a new application, and I can't find it in VAIO Space
J After you install a new application, you need to add it to VAIO

Space. See "Adding and Removing Applications in VAIO Space" on 
page 26 for details.

When I double-click an application icon, a message such as "You must insert
the application CD into your CD-ROM drive" appears and the software does
not start
_i Some titles require specific files that are located on the application's 

CD-ROM disc. Insert the disc and try starting the program again.
□ Check to make sure you inserted the CD-ROM disc with the label 

side facing up.

My software program "locks up" or crashes
□ Contact the software publisher or designated provider for technical 

support. See the About Your Sony PC guide for a complete list of 
phone numbers.

My speakers have no sound
□ Check that the speakers are plugged into the HEADPHONES connector. 

See "Connecting the Sony Multimedia Computer Display" on page 7 
or "Connecting a Display, Speakers, and a Microphone" on page 8 for 
details.

□ If the speakers have a mute button, make sure it is off.
□ If the speakers are powered by batteries, check that the batteries are 

inserted properly and that they are charged.
□ If fhe speakers use an external power source, make sure that the 

power cord is plugged into a grounded wall outlet or power strip.
□ If the speakers have their own volume control, check the volume 

level.
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□ If the progfam you are using has its own volume control, check that 
the volume is turned up.

□ Check the volume controls in the application, in the Sony A/V Suite 
Mixer, and in Windows 95.

My modem doesn't work
□ Check that the phone line is plugged into the LINE jack. See 

"Connecting the Phone Line and Phone" on page 11 for details.
□ Check that the phone line is working. You can check the line by 

plugging in an ordinary phone and listening for a dial tone.
□ Check that the phone number the program is dialing is correct.
□ Check that the software you are using is compatible with the Sony PC 

modem. (All preinstalled programs are compatible.) Call the software 
publisRer or Sony Online Support.

My microphone doesn't work
□ Check that the microphone is plugged into the MIC connector. See 

"Connecting the Sony Multimedia Computer Display" on page 7 
or "Connecting a Display, Speakers, and a Microphone" on page 8 
for details.

My mouse doesn't work
□ Check that the mouse is plugged into the MOUSE connector. See 

"Connecting the Keyboard and Mouse" on page 10 for details.
□ There may be dust or dirt inside the mouse mechanism. To clean the 

mouse, follow these steps:
□ Turn off your PC. See "Shutting Down Your Sony PC" on page 35 

for details.
□ Remove the mouse ball cover on the back side of the mouse.
□ Turn the mouse upright, and drop the mouse ball into your hand.
□ Using a piece of tape, remove any dust or dirt on the mouse ball 

and inside the mouse ball socket.
□ Return the mouse ball to the socket, and replace the mouse ball 

cover.
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My keyboard doesn't work
□ Check that the keyboard is plugged into the KEYBOARD connector. See 

"Connecting the Keyboard and Mouse" on page 10 for details.

I can't find the Windows 95 taskbar
□ Use the mouse to point to the bottom of the screen below the VAIO 

Space Floor area. The taskbar should come into view.
□ If you still don't see the taskbar, someone may have changed the 

taskbar's position. Point to the left, right, and top edges of the screen.

I can't make the VAIO Space wall that I want to use rotate into view
□ Point to the wall you want to use, wait for the green arrow to appear, 

and then click the wall.

I can't use two different applications at the same time in VAIO Space
□ Click the Settings icon on the VAIO Space Floor. Under VAIO Space 

Setting, select VAIO background mode.
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Using the^Recovery CD
You can restore the software titles on your computer if they become 
corrupted or accidentally erased. The Recovery CD contains a backup 
copy of the software originally installed on your hard disk drive. It can be 
used only with a Sony PC. You can choose to:

□ Restore all the software titles that originally came with your 
computer without formatting the hard disk

□ Format the hard disk drive and then restore all the original software 
Caution

/i\Fonnatting the hard disk drive removes all the information on the hard disk. If 
you choose this option, you will lose any software you've installed and any other 
files you've created since you started to use your computer. This means you will 
hiwe to reinstall any applications that were iwt included with the computer ■  
when you purchased it. If you choose to restore all software titles without 
formatting the hard disk drive, you may need to reinstall applications that were 
not included with the computer when you purchased it. If you have any 
cjuestions on using the Recovery CD, contact Sony Online Support (SOS).

To use the Recovery CD 
Note
^ Your PC may include more than one Recovery CD.

Insert the Sony PC Recovery CD in the CD-ROM drive. 

Shut down your PC as described on page 35.

Wait 30 seconds and turn on your PC.

Click OK on the Welcome screen.

When the Recovery menu appears, follow the on-screen instructions 
to complete the recovery process.
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Upgrading and Maintaining 
Your Sony PC

In the future you may want to install additional boards to expand the 
functionality of your PC. This section describes how to open your PC and 
insert add-in boards, add memory, and replace the cover. This section 
also explains how to change the lithium battery. For more information on 
upgrading your Sony PC, see the online System Reference Manual.

The procedures in this section assume that you are familiar with the 
general terminology associated with personal computers and with the 
safety pract^es and regulatory compliance required for using and 
modifying electronic equipment. Read "Notes on Use" on page 109 
before upgrading your Sony PC.

Caution
Always switch the power off before you open the system or connect your PC to 
peripheral equipment; otherwise, damage may occur to the integrated circuits in 
your PC.

Electrostatic discharge (ESD) can damage disk drives, add-in cards, and other 
components. Do the procedures described here only at an ESD workstation. If such a 
station is not available, do not work in a carpeted area and do not handle materials 
that produce or hold static electricity (cellophane wrappers, for example). Ground 
yourself by maintaining continuous contact with an unpainted metal portion of the 
chassis while performing the procedure.
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Removing the Cover
To insert an add-in board, add memory, or replace the lithium battery, 
you need to open your Sony PC. You must remov'e the panels in a specific 
order: the left side panel, the rear panel, and the I/O bracket.

Note
When replacing the lithium battery, you must perform some initial steps before 
removing the cover. See "Replacing the Lithium Battery" on page 97 for details.

To remove the left side panel

1 Push the rear latch to release the left side panel.

2 Slide the panel back until it stops.

3 Pull the panel straight out to remove it.
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To remove the rear panel 
Note
^ You do not need to remove the rear panel to replace the lithium battery. 

□ Push the tabs to unsnap and remove the rear panel.
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To remove the I/O bracket 
Note
^ You do not need to remove the I/O bracket to add memory or replace the 

lithium battery.

□ If you are installing or removing an add-in board, unscrew the 
I/O bracket.
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Inserting^an Add-in Board
You can add ISA or PCI boards to the system. After removing the side 
and rear panels and the I/O bracket, identify the connector where you 
want to insert the add-in board.

Caution
Make sure you observe the proper safety precautions when you add boards to your 
Sony PC. See "Notes on Use" on page 109.

To insert an add-in board

1 Shut down your PC, turn off all peripheral devices, such as your 
printer, display, and speakers, and then unplug your PC.

2 Remove the side and rear panels and the I/O bracket as described 
on page 90.

3 Remove the slot cover for the slot you have chosen.

93



Upgrading and Maintaining Your Sony PC

4 Install the add-in card by plugging it into the connector on the system 
board. Attach any internal cables that the board requires (see the 
manual for the add-in card).

5 Replace the cover as described on page 99.
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Adding M^ory
You can install additional SIMMs (single in-line memory modules) in 
your PC, to a maximum of 128 megabytes (MB).

Note
^ You must install SIMMs in pairs. Fill each memory bank with SIMMS of the same 

type (Fast Page or EDO), speed (60 ns), and size (4, 8,16, or 32 MB).

Total System 1 Memory in Bank 0^ Memory in Bank V
Memory Socket 1 Socket 2 Socket 1 Socket 2
32 MB* 16 MB 16 MB Empty Empty
40 MB 16 MB 16MB 4 MB 4 MB
48 MB SMB SMB 16 MB 16 MB
64 MB 16 MB 16 MB 16 MB 16 MB
64 MB 32 MB 32 MB Empty Empty
72 MB 32 MB 32 MB 4 MB 4 MB
80 MB SMB SMB 32 MB 32 MB
96 MB 16 MB 16 MB 32 MB 32 MB
128 MB :32 MB 32 MB 32 MB 32 MB

32 MB is the default memory amount for PCV-70 and PCV-90.

* The memory options in Bank 0 and Bank 1 are interchangeable.

Caution
Make sure you observe the proper safety precautions when you add SIMMs to your 
Sony PC. See "Notes on Use" on page 109.

To install memory

1 Shut down your PC, turn off all peripheral devices, such as your 
printer, display, and speakers, and then unplug your PC.

2 Remove the side and rear panels as described on pages 90-91.

3 If necessary, remove any add-in cards or other components to access 
the SIMM sockets.

4 Handle the SIMM only by the edges, and remove it from its anti-static 
package.
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5 Hold the SIMM with the chips face up and align the SIMM over the 
SIMM socket as shown.

6 Firmly insert the SIMM at an angle into the bottom edge of the SIMM 
socket. Press evenly against the edge of the SIMM as you raise it into 
the SIMM socket.

Caution
A\To avoid damaging the SIMM socket, move the SIMM socket tabs slightly 

outward to relieve pressure. The SIMM should then click easily into place.

7 Reinstall any add-in cards or components you removed.

8 Replace the side and rear panel as described on page 99.
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Replacing^he Lithium Battery
After several years, when the lithium battery starts to weaken, the system
settings stored in CMOS RAM, such as the date and time, may be wrong.
When this occurs, you need to replace the lithium battery.

To replace the lithium battery

1 To run the Setup utility, press F3 for a few seconds while rebooting 
your PC, then press and hold FI to run the BIOS setup utility.

2 Write down the current BIOS Setup options.

3 Shut down your PC, turn off all peripheral devices, such as your 
printer, display, and speakers, and unplug your PC.

4 Remove the side panel as described on page 90.

5 If necessary, remove any add-in cards or other components to access 
the CMOS battery socket, and gently pry the battery from the socket.
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6 Install the new battery with the plus (+) side up.

WARNING
A\Tlu’rc is danger of explosion if you replace the battery incorrectly. You must 

replace the battery only with a CR2032 type lithium battery. Discard used 
batteries according to the instructions on page 210.

7 Reinstall any add-in cards that were removed, and replace the side 
panel as described on page 101.

Note
^ The values stored in the CMOS memory are now reset to the factory default 

values. You must run the Setup utility to reset the date, time, passwords, and 
other options. See the online System Reference Manual for details.

8 To run the Setup utility, press F3 for a few seconds while rebooting 
your PC, then press and hold FI to run the BIOS setup utility.

9 Change the default values to the values you wrote down in step 2.

10 Save your Setup changes, and then exit the Setup utility.
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Replacing the Cover
Replace the panels in the following order:

To replace the cover

1 Replace the I/O bracket.

Use the two screws to hold it in place.
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2 Replace the rear panel.

Make sure the tabs snap into place.
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.3 Replace the side panel.
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Computer Basics

Using the Keyboard
Your keyboard is very similar to a typewriter's, but the keyboard has 
additional keys that perform specific computer-related tasks.

Print Screen key

Escape 
key

Function
keys

Correction
keys

Numeric
keypad

Navigation
keys

Key
Numeric keypad

Navigation keys

Correction keys

Description
Contains the keys found on a typical calculator. Use 
the numeric keypad to type numbers or to perform 
mathematical calculations such as addition and 
subtraction. Note that you must press NUM LOCK to 
activate the numeric keypad. (When you do so, the 
Num Lock light will be on.)
Several keys are devoted to moving the cursor on the 
screen (the four arrow keys and the HOME, END, PAGE 
UP, and PAGE DOWN keys). These keys are also 
available on the numeric keypad when Num Lock is 
turned off.
The INSERT and DELETE keys enable you to make 
corrections in your documents. These keys are also 
available on the numeric keypad when Num Lock 
is turned off.
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Key
Function keys

Escape key 
Print Screen key

Operator keys

Windows 95 keys

Description
The twelve function keys along the top of the keyboard 
are used to perform designated tasks. For example, in 
many applications, FI is the Help key. The task 
associated with each function key may vary from one 
application to the next.
The ESC (Escape) key is used to cancel commands 
The PRINT SCREEN key takes an electronic snapshot of 
the screen and places it in the Windows Clipboard. You 
can then paste the screen shot into a document and print 
it.
Several keys are always used with at least one other key: 
CTRL, ALT, and SHIFT. When held down with another 
key, the CTRL (Control) and ALT (Alternate) keys offer 
another way to give commands. For example, in many 
applications, instead of choosing the Save command 
from a menu, you can hold down CTRL and press S 
(referred to as CTRL+S). The SHIFT key operates the 
same way as on a typewriter; it's used to produce capital 
letters or special symbols such as @ and $.
The keys with the Windows logo display the Windows 
95 Start menu; it's the equivalent of clicking the Start 
button on the taskbar. The Applications key displays a 
shortcut menu of context-sensitive choices; pressing this 
key is the equivalent of clicking the right mouse button.

The keyboard also has three lights;

Light
Num Lock

Cap Lock

Scroll Lock

On
The number keys on the 
numeric keypad 
are active.
Letters appear in 
uppercase as you type. 
The SHIFT key lowers 
the case of typed letters 
when Cap Lock is on.
The screen scrolls 
differently. (Exactly 
how it scrolls depends on 
the specific application. It 
has no effect in many 
applications.)

Off
The arrow keys, navigation 
keys, and correction keys on 
the keypad are active.
Letters appear in lower case 
as you type (unless you hold 
down the SHIFT key).

Information moves across the 
display normally.
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Using the1\^ouse
Using a mouse may be difficult at first, but after you become comfortable
using it, you can save a lot of time. The following terms are commonly
used to describe actions you perform with a mouse.

Term Description
Point Place the mouse pointer on an item or object.
Click Press and release the left mouse button, without moving the

mouse.
Double-click Press the left mouse button two consecutive times, without 

moving the mouse.
Right-click Press the right mouse button. In many applications, this

—. action displays a shortcut menu of context-sensitive choices.
Drag Hold down the left mouse button and then move the mouse

in the desired direction. This action is used to select text and 
move objects.
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Setting Up the Mouse for Left-Hand Use
You can control the mouse with your right or left hand. When you use the 
mouse with your left-hand, you may find it easier to reverse the button 
functions. When the functions are reversed, the right mouse button is 
used for normal clicking and dragging, and the left button is for 
displaying shorfcuf menus (right-clicking).

To set up the mouse for left-hand use

1 Click the Start button to display the Start menu.

2 Point to Settings.

3 Click Control Panel.

4 Double-click the Mouse icon.

5 Click the Buttons tab.

6 Under Buttons, select Left-handed.

7 Click the OK button to close the Mouse Properties dialog box.
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Using the1Zi)-ROM Drive
To use the CD-ROM drive, you must open the front panel. See "Accessing 
the CD-ROM and Diskette Drives" on page 18 for details.

To use the CD-ROM drive

1 Press the Eject button on the front panel of the PC to open the 
CD-ROM drive. The CD tray slides out.

2 Place the CD-ROM disc in the tray with the label side facing up.

3 Close the tray by pushing it gently or by pressing the Eject button.
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Using the Diskette Drive
To use the diskette drive, you must open the front panel. See “Accessing 
the CD-ROM and Diskette Drives" on page 18 for details. Most diskettes 
contain a write-protect tab. The write-protect tab prevents accidental 
changes to a diskette. When the hole is open, the diskette is write- 
protected—you can't delete, copy, or save information on the diskette. 
When the hole is closed, you may write to or modify the diskette 
contents. Just slide the write-protect tab to open and close the hole.

To use the diskette drive

1 Hold the diskette with the label side facing up.

2 Gently push the diskette into the drive until you hear it click 
into place.

3 After you finish using the diskette, press the Eject button on the 
diskette drive to remove the diskette.

Write-protect tab
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Notes on Use

On the Power Source
□ Your PC operates on 100-120 V AC 50/ 60 Hz (for North American 

countries) or 220-240 V AC 50 Hz (for European countries).
□ Be sure to set the voltage setting switch to the correct setting before 

turning on the power; otherwise damage may occur.
□ The total power draw of installed add-in cards must not exceed the 

specifications for the power supply. Do not overload the system by 
installing add-in cards that draw excessive current. The system is 
designed to provide 2 amps (average) of 5V power for each card in 
the system not to exceed a total of 12 amps. The total 5V current draw 
in a fully-loaded system (with all the add-in card slots filled) must 
not exceed 12 amps. If you add components to the system that draw 
current from the power supply, the total combined +3.3V and +5V 
currents must not exceed 80 watts.

□ Plug all the power cords for your PC and its peripheral equipment 
into the same AC supply line. AC derived from different supply lines 
may result in voltage differences that can cause unstable operation or 
unwanted weak currents at the time of connection.

□ Do not share the AC outlet with any other power-consuming 
equipment, such as copying machines or shredders.

□ You can purchase a power strip with a surge protector. This device 
prevents damage to your PC caused by sudden power surges such as 
those that may occur during ah electrical storm.

□ If you live in an area that experiences frequent power fluctuations, 
you may want to purchase a UPS (Uninterrupted Power Supply). 
This device contains both a surge protector and a battery backup. The 
surge protector prevents damage to your PC caused by power surges. 
The battery backup safeguards your data during a brief period of 
power loss.
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□ Do not place heavy objects on the power cord.
□ Do not operate the system with the cover remov’ed. Always 

reinstall the cover before turning on the system.
□ To disconnect the cord, pull it out by the plug. Never pull the 

cord itself.
□ Unplug your PC from the wall outlet if you will not be using the 

PC for a long time.
□ The power control button on the front panel does not turn off the 

system AC power. To remove power from the system, you must shut 
down the PC as described in this manual and then unplug the AC 
power cord from the wall outlet or power strip.

□ Before touching anything inside the computer, turn the system off 
and let it cool for ten minutes. This will ensure that the processor heat 
sink will not be hot.

□ Do not attempt to open the power supply. There are no user- 
serviceable parts in the power supply. To avoid personal injury or 
damage to your equipment, refer the repair or replacement of the 
power supply to qualified personnel only.

On Disposal of the Lithium Battery
□ Dispose of the lithium battery properly. In some areas, the disposal of 

lithium batteries in household or business trash may be prohibited. 
You can return your unwanted lithium batteries to your nearest Sony 
Service Center or Factory Service Center. For the Sony Service Center 
nearest you, call 1-800-222-SONY (1-800-222-7669).
Caution
A Do not handle damaged or leaking lithium batteries.

WARNING
A\The lithium battery may explode if mistreated. Do not disassemble it or 

dispose of it in fire.
Replace the battery with a Sony CR2032 lithium battery. Using a type of 
battery other than a CR2032 may present a risk of fire or explosion.
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On Handling
□ Clean the cabinet with a soft, dry cloth or a soft cloth lightly 

moistened with a mild detergent solution. Do not use any type of 
abrasive pad, scouring powder, or solvent such as alcohol or benzine, 
as it may damage the finish of your Sony PC.

□ Should any solid object or liquid fall into the cabinet, keyboard, or 
mouse, shut down your PC and then unplug it. You may want to 
have the PC checked by qualified personnel before operating it any 
further.

On Installation
□ Do not place your Sony PC in a location subject to;

□ HSt sources, such as radiators or air ducts
□ Direct sunlight
□ Excessive dust
□ Moisture or rain
□ Mechanical vibration or shock
□ Strong magnets or speakers that are not magnetically shielded
□ Ambient temperature of more than 95^¥ (35^C) or less than 

50«F (10«C)
□ High humidity

□ Do not place electronic equipment near your PC. The PC's 
electromagnetic field may cause a malfunction.

□ Provide adequate air circulation to prevent internal heat 
build-up. Do not place your PC on loose surfaces (such as rugs or 
blankets) or near materials (such as curtains or draperies) that may 
block its ventilation slots. Leave a Space of at least 8 inches from the 
back panel of your PC.
The PC uses high-frequency radio signals and may cause interference 
to radio or TV reception. Should this occur, relocate the PC a suitable 
distance away from the set.
Use only specified peripheral equipment and interface cables; 
otherwise, problems may result.

□ Do not use cut or damaged connection cables.

□

□
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Always switch the power off before connecting your PC to peripheral 
equipment; otherwise, damage may occur to the integrated circuits in 
your PC.
Your PC, keyboard, and mouse consist of high-precision electronic 
parts. Do not drop them or bump them against other objects.
Your Sony PC will not work with party lines, cannot be connected to 
a coin-operated telephone, and may not work with multiple phone 
lines or a private branch exchange (PBX).
If fhe telephone company makes a service call to your home or 
office and determines that your PC is responsible for the problem, the 
telephone company may bill you for the service call. Also, if you do 
not disconnect your PC when it is adversely affecting the telephone 
line, the telephone company has the right to disconnect your service 
until you correct the problem.

On Moisture Condensation
If your PC is brought directly from a cold location to a warm one, 
moisture may condense inside your PC. In this case, allow at least an 
hour before turning on your PC. If any problem occurs, unplug your PC, 
and contact your Sony Service Center.

On Upgrading the System
□ The procedures described in the "Upgrading and Maintaining Your 

Sony PC" section in this manual assume familiarity with the general 
terminology associated with personal computers and with the safety 
practices and regulatory compliance required for using and 
modifying electronic equipment.

□ Disconnect the system from its power source and from any 
telecommunications links, networks, or modems before you open the 
system or do any of the procedures described in the "Upgrading and 
Maintaining Your Sony PC" section in this manual. Failure to do so 
may result in personal injury or equipment damage.
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□

Electrostatic discharge (ESD) can damage disk drives, add-in 
cards, and other components. Do the procedures described in the 
“Upgrading and Maintaining Your Sony PC" section only at an ESD 
workstation. If such a station is not available, do not work in a 
carpeted area, and do not handle materials that produce or hold static 
electricity (cellophane wrappers, for example). Ground yourself by 
maintaining contact with an unpainted metal portion of the chassis 
while performing the procedure.
When removing a slot cover, be careful not to damage components 
on the system board or add-in cards. You may need to temporarily 
remove add-in cards that are next to the slot cover you want to 
remove.

On Usin§4he Hard Disk Drive
□ Do not place the PC in a location that is subject to vibration 

or shock.
□ Do not move the PC during operation.
□ Do not subject the PC to sudden changes in temperature.
□ Do not turn off the power while the PC is accessing the hard 

disk drive.

On Handling Diskettes
□ Do not open the shutter manually and touch the surface 

of the diskette.
□ Keep diskettes away from magnets.
□ Keep diskettes away from direct surilight and other heat sources.

On Handling CD-ROM Discs •
□ Do not touch the surface of the disc.
□ Do not drop or bend the disc.
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On Cleaning CD-ROM Discs
□ Fingerprints and dust on the surface of a disc may cause read 

errors. Proper care of the disc is essential to maintain its reliability. 
Do not use solvents such as benzine, thinner, commercially available 
cleaners or anti-static spray, as they may cause damage to the disc.

□ For normal cleaning, hold the disc by its edge and use a soft cloth 
to wipe the surface from the center out.

□ If the disc is badly soiled, moisten a soft cloth with water, wring it out 
well, and use it to wipe the surface of the disc from the center out. 
Wipe off any remaining moisture with a dry soft cloth.
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Regulatory Information
This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the Rules. These 
limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will 
not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the 
following measures:

□ Reorient or relocate the receiving antenna.
□ Increase the separation between the equipment and the receiver.
□ Connect the equipment into an outlet on a circuit different from that 

to which the receiver is connected.
□ Consult the dealer or an experienced radio/TV technician for help.
Any changes or modifications not expressly approved by the grantee of 
this device could void the user's authority to operate the equipment. The 
customer is responsible for ensuring compliance of the modified product.

Only peripherals (computer input/output devices, terminals, printers, 
etc.) that comply with FCC Class B limits may be attached to this 
computer product. Operation with non-compliant peripherals is likely 
to result in interference to radio and television reception.

All cables used to connect peripherals must be shielded and grounded. 
Operation with cables, connected to peripherals, that are not shielded and 
grounded, may result in interference to radio and television reception.
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FCC Part 68
This equipment complies with Part 68 of the FCC rules. The ringer 
equivalence number (REN) and the FCC registration number are printed 
on the modem board. If requested, this information must be supplied to 
the telephone company.

The REN is used to determine the quantity of devices which may be 
connected to the phone line. Excessive REN's on the telephone line may 
result in the devices not ringing in response to an incoming call. In most, 
but not all areas, the sum of the REN's should not exceed five (5.0). To be 
certain of the number of devices that may be connected to the line, as 
determined by the total REN's, contact the telephone company to 
determine the maximum REN for the calling area.

This modem uses the USOC RJ-11 telephone jack.

If this equipment causes harm to the telephone network, the telephone 
company will, when practical, notify you in advance that temporary 
discontinuance of service may be required. If advance notice isn't 
practical, the telephone company will notify you as soon as possible. 
Also, you will be advised of your right to file a complaint with 
the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, 
operations or procedures that could affect the operations of the 
equipment. If this happens, the telephone company will notify you in 
advance, in order for you to make the necessary modifications 
in order to maintain uninterrupted service.

If trouble is experienced with this modem, for repair or warranty 
information, please contact 1-888-4SONY-PC, or write to the Sony 
Customer Information Center, One Sony Drive, Park Ridge, NJ 07656.

This equipment cannot be used on telephone-company-provided coin 
service. Connection to Party Line Service is subject to state tariffs.

Repair of the modem should be made only by a Sony Service Center or 
Sony authorized agent. For the Sony Service Center nearest you, call 
1-800-222-SONY (1-800-222-7669).
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Telephone Consumer Protection Act of 1991
The Telephone Consumer Protection Act of 1991 makes it unlawful for 
any person to use a computer or other electronic device to send any 
message via a telephone facsimile machine unless such message clearly 
contains, in a margin at the top or bottom of each transmitfed page or on 
the first page of the transmission, the date and time it is sent and an 
identification of the business, other entity, or individual sending the 
message, and the telephone number of the sending machine or such 
business, other entity, or individual.

In order to program this information into your facsimile, see your fax 
software documentation.
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Add Movie window 32 
add-in boards 93-94 
adding additional hardware 13-14 

add-in boards 93-94 
precaution 110

adding additional software 26-27 
problems with 84 

adding icons 27, 32 
adding memory 95-96 
adding printers 13 
adjusting speaker volume 84 

AudioView 59, 60 
CD Player 43 
MIDI Player 63 
Mixer 40, 41 
Video File Player 71 
WAV Player 50

adjusting voltage settings 12,109 
air circulation 111 
Alt keys 104
amplitude See adjusting speaker 

volume
animated icons (VAIO Space) 23, 29 
application icons, adding 27, 32 
Application Wall (VAIO Space) 25 

launching applications 25

applications
launching 24, 25, 30 

problems with 84 
moving between 33 
organizing 21 
recovering 87 

attaching cables 6
See also connectors 

AUDIO button (Video CD) 76 
audio modes (Video CD) 76 
audio See Sony A/V Suite 
AUDIOVIEW button 50, 55 
AudioView window 55 

See also WAV Player 
adjusting volume 59, 60 
copying WAV segments 58-60 
cutting WAV segments 55-57 
menus 60 
opening 55 
recording sounds 61 
selecting segments 56 

auxiliary devices 68 
adjusting 40 

AVI files 69
See also video files

B
back panel (illustrated) 6 
background noise, removing 59 
backup files (preinstalled software) 87 
battery

disposing 110 
replacing 97-98 

caution 98
browsers (Internet) 24 

setting preferences 31
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cables 6, 111
See also connectors 

canceling commands 104 
CD formats (enhanced) 74 
CD INFO button (Video CD) 76 
CD Player 40,42-4«

See also Video CD Player 
adjusting volume 43 
changing playlists 48 
controls 43
creating playlists 43,46-47 
labeling tracks 45 
naming CDs 44 
starting 42

CD Playlist Edit dialog box 44,45,46,48 
CD Tracks list 45 
CD tray

closing 43, 76,107 
opening 43, 76,107 

problems with 83 
CD-ROM drives 18 

cleaning 114 
troubleshooting 83, 84 
using 42,107

CDs
handling 113 
playing 42, 84,107 

from playlists 46 
changing CD tracks 43 
changing defaults 31 

Video CD Player 75 
changing playlists 

CD player 48 
MIDI Player 67 
Video File Player 73 
WAV Player 54 

changing sound effects 55-60 
undoing changes 59 

children's software 25 
choosing locations 4-5, 111 
choosing startup desktop 31

cleaning
CD-ROM drives 114 
computer 111 
mouse 85 

click (defined) 105 
Clipboard

loading WAV files 60 
saving contents 60 

closing
Add Movie window 32 
CD tray 43, 76,107 
My Space window 30 
Net Space window 24 
Sony VAIO Space 34 

computer
adding functionality 13 
adjusting voltage settings 12,109 
back panel illustrated 6 
cleaning 111 
condensation and 112 
disposing of battery 110 
locking up 83
protecting your investment 12,17 
registering 17
removing cover 89, 90-92,110 
replacing battery 97-98 

caution 98
replacing cover 99-101 
safety information iii 
setting up 3-5

online support 79 
precautions 111 

shutting down 35,110 
starting 15

problems with 83 
unpacking 3 
upgrading 89,112

CONFIGURE button (Video CD) 75, 76 
connectors 6

additional components 13-14 
keyboard 10 
mouse 10
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Multimecia Computer Display 7 
nonstandard equipment 8 
palmrest 9 
phone 11
power cords 12,109 
precautions 111 

CONTINUE button 
CD Player 43 
MIDI Player 63 
Video File Player 71 
WAV Player 50 

continuous play 
CDs 43
enhanced CDs 75 
music files 63 
sourid effects 50 
videos 71

converting WAV file formats 60 
copying sound segments 58-60 
correction keys (described) 103 
creating MIDI files 63, 68 
creating playlists

CD Player 43, 46-47 
MIDI Player 63, 64-65 
Video File Player 69-70 
WAV Player 50, 51-52 

creating WAV files 50,61 
Crossfade command 60 
Ctrl keys 104
cursor-movement keys (described) 103 
customer assistance 17, 24 

support options 79 
customizing

VAIO space 30-32 
Video CD Player 75, 76 

cutting WAV segments 55-57

D
data

preventing loss 35 
saving 108

DC Offset command 60 
dead spots (WAV files) 55, 60

default settings, changing 31 
Video CD Player 75 

DELETE key 103 
deleting background noise 59 
desktop 21

See also Sony VAIO Space 
selecting startup 31 

dictionaries 25
disconnecting power cords 110 
diskette drives 18,108 
diskettes

handling 113 
inserting into drive 108 
writing to 108

display modes (Video Player) 71 
displaying the taskbar 33 

problems with 86 
displays

See also Sony Multimedia 
Computer Display 

adjusting resolution 75 
CD Player 42 
connecting 8 
screen savers 69 
setting up 5 
turning on 15

problems with 83 
double-click (defined) 105 
drag (defined) 105 
drives 18,108

Echo button (AudioView) 59 
Edit menu (AudioView) 60 
editing sound effects 55-60 

undoing changes 59 
Eject button

CD Player 43 
Video CD Player 76 

electronic
documentation 79 
equipment 111 
registration 17
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electrostatic discharge 89 
e-mail support 79 
encyclopedias 25 
enhanced CDs 74 
Esc key 104
European power settings 109 
Exit icon 29, 34
Exit VAIO Space dialog box 34

Fade button (AudioView) 59 
Fast forward button 

AudioView 59 
CD Player 43 
MIDI Player 63 
Video CD Player 75 
Video File Player 71 
WAV Player 50 

faxes, sending 117
financial management applications 25
Find Peak command 60
flat spots (WAV files) 55,60
Floor (VAIO Space) 29-35
floppy drives 18,108
function keys (described) 104

Game Arcade 25 
GAME connector 14 
glare 5
grounding 89

H
Halve Sample Rate command 60 
handling CDs 113 
handling diskettes 113 
hard disk 113

reformatting 87 
hardware

adding additional 13-14, 93-94 
precaution 110

electrostahc discharge and 89 
installing memory boards 95-96

nonstandard 8 
online support 79 
regulatory information 115-117 
removing panels 90 
replacing panels 99 
troubleshooting 83, 84, 86 

headphones
caution for use 40 
connecting 7, 8

HEADPHONES connector 7, 8 
help 79

See also troubleshooting 
Help icon 29 
Help key 104

I
icons

adding 27, 32 
VAIO Space 23, 29 

incorrect voltage settings 12 
indicator lights 

A/V Suite 39 
keyboard 104 

input devices 115 
setting up 4 

INSERT key 103 
Insert Silence conunand 60 
inserting diskettes into drive 108 
installing additional hardware 13-14 

add-in boards 93-94 
precaution 110

installing additional memory 95-96 
installing additional software 26-27 

problems with 84 
interference 111, 115 
Internet access 23, 31 
Internet browsers 24

setting preferences 31 
INTRO button 

CD Player 43 
MIDI Player 63 
Video File Player 71 
WAV Player 50
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Invert Samples command 60

joysticks 13
connecting 14

Karaoke 74, 76 
keyboard 4,103-104 

connecting 10 
indicator lights 104 
troubleshooting 86 

KEYBOARD coimector 10 
Kid's Land 25

labeling tracks 45 
launching applications 24,25,30 

problems with 84 
launching Sony A/V Suite 37 
launching Sony VAIO Space 34 
Load File Into Clipboard command 60 
loading MIDI files 62 
loading WAV files 49 
locations, choosing 4-5, 111 
losing data (caution) 35 
losing power 109

M
Master setting 40 
memory, adding 95-96 
menus 105

AudioView window 60 
canceling commands 104 

MIC connector 7,8 
microphones 3 

adjusting 40 
coimecting 7,8 
troubleshooting 85 

MIDI devices 13 
connecting 14 

MIDI files
adding to playlists 64

creating 63, 68 
loading 62
removing from playlists 67 
saving 68

MIDI instruments 68 
MIDI ORCH button 62 
MIDI Orchestrator 62 
MIDI Player 40.62-68 

adjusting volume 63 
changing playlists 67 
controls 63
creating playlists 63,64-65 
playing playlists 66 
recording 63,68 
starting 62

MIDI Playlist dialog box 62, 64, 66, 67 
minimizing glare 5 
Mix Paste command 60 
Mixer (A/V Suite) 40-41 

controls 40 
moving sliders 41 

mixing sounds 40,55 
by copying over 60 

model numbers iii 
modems 117

troubleshooting 85 
money management applications 25 
MONITOR connector 7,8 
monitors See displays 
mono sound files 60 
mono video CDs 75 
More A/V window 77 
mouse 4,105-106 

cleaning 85 
coimecting 10 
troubleshooting 85 

mouse buttons
assigning sounds to 31 
reassigning 106 

MOUSE connector 10 
movies 32, 69

setting preferences 31 
showing 72
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moving
A/V sliders 41 
among applications 33 
objects 105 
taskbar 33 

MPEG files 32, 69
See also video files 

Multimedia Computer Display See 
Sony Multimedia Computer 
Display

multimedia reference materials 25 
multimedia See Sony A/V Suite 
multiple applications, moving among 

33
music files See MIDI files 
Mute button

CD Player 43 
MIDI Player 63 
Mixer 41
Video CD Player 75 
Video File Player 71 
WAV Player 50 

My Space icon 29 
My Space window 30

N
Name CD dialog box 44 
Name Track dialog box 45 
navigation keys (described) 103 
Net Space window 23, 24 
Next file button 

MIDI Player 63 
WAV Player 50 

Next track button 
CD Player 43 
Video CD Player 75 

Next video button (Video File) 71 
Noise Gate button (AudioView) 59 
nonstandard equipment 8 
Normalize button (AudioView) 59 
NUM LOCK key 103 
numeric keypad (described) 103

objects, moving 105 
online

help 79
registration service 17 
services 23, 24 
support 17, 24 

options 79 
online help

See also troubleshooting 
opening

Add Movie window 32 
applications 24, 25, 30 

problems with 84 
AudioView window 55 
CD tray 43, 76,107 

problems with 83 
MIDI files 62 
More A/V window 77 
My Space window 30 
Net Space window 23 
Sony A/V Suite 37 
Sony VAIO Space 34 
VAIO Space Setting window 31 
WAV files 49

operator keys (described) 104 
output devices 115 

adding 13-14
output modes (Video CD) 75

P
palmrest 4

connecting 9 
panels

removing 90 
replacing 99 

Pause play button 
AudioView 59 
CD Player 43 
MIDI Player 63 
Video CD Player 75 
Video File Player 71
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WAV Player SO 
PC See computer 
PCM WAV files 60 
phones 8,117

connecting 11 
service precautions 112 
technical support and 80 

Play button
CD Player 42 
MIDI Player 62 
Video CD Player 75 
WAV Player 49

Play Range button (AudioView) 59 
playing

CDs 42, 84, 107
from playlists 46 

enhanced CDs 74 
MIDI files 62, 64, 66 
videos 72
WAV files 49, 52, 53 

PLAYLIST button 
CD Player 43 
MIDI Player 63 
WAV Player 50 

playlists 39
CD Player 43, 46-48 

saving 47
MIDI Player 63, 64-67 

saving 65
Video File Player 69-73 

saving 70
WAV Player 50, 51-54 

saving 52
plugging in connectors 6 
point (defined) 105 
power cords 12,109 

disconnecting 110 
power fluctuations or loss 109 
{X)wer source, precautions 109-110 
power switch 15 
preferences (VAIO Space) 30-32

preinstalled software 21, 25 
accessing 25 
online support 79 
previewing 29 
restoring 87

previewing preinstalled software 29 
Previous file button 

MIDI Player 63 
WAV Player 50 

Previous track button 
CD Player 43 
Video CD Player 75 

Previous video button (Video File) 71 
Print Screen key 104 
PRINTER connector 13 
printers 13
problem solving 83-86 
productivity tools 25 
protecting your investment 12,17

quitting Sony VAIO Space 34

radio interference 111, 115 
reassigning mouse buttons 106 
rebooting system 83 
Record button

MIDI Player 63 
WAV Player 50 

recording music 63, 68 
recording serial numbers Hi 
recording sound effects 50, 61 
Recovery CD 87 
reducing glare 5 
Reference Library 25 
reformatting hard disk 87 
registering Windows 95 16 
registering your computer 17 
regulatory information 115-117 
Remote Command Security 

dialog box 82
removing background noise 59
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removing computer cover 89,90-92, 
110

removing diskettes 108 
removing software 28 
REPEAT button 

CD Player 43 
MIDI Player 63 
Video CD Player 75 
Video File Player 71 
WAV Player 50 

repeating playlists 43, 50, 63, 71 
replacing battery 97-98 

caution 98
replacing computer cover 99-101 
resolution (Video CD) 75 
restoring preinstalled software 87 
Reverse command 60 
Rewind button 

Audio View 59 
CD Player 43 
MIDI Player 63 
Video CD Player 75 
Video File Player 71 
WAV Player 50 

right-click (defined) 105

safety information iii 
Save Clipboard command 60 
saving data 108 
saving MIDI files 68 
saving playlists 

CD Player 47 
MIDI Player 65 
Video File Player 70 
WAV Player 52 

saving WAV files 61 
Scale button (AudioView) 59 
SCREEN button 

Video CD 75 
Video File 71 

screen savers 69 
screens, reducing glare 5
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SEARCH button (Video CD) 75 
selecting

locations 4-5, 111 
startup desktop 31 
text 105

sending faxes 117 
serial numbers iii 
service providers (Internet) 31 
setting up Windows 95 16 
setting up your PC 3-5 

back panel illustrated 6 
online support 79 
precautions 111 

Settings icon 29, 31 
Shift keys 104 
SHUFFLE button 

CD Player 43 
MIDI Player 63 
Video File Player 71 
WAV Player 50

shutting down your computer 35,110
signal-to-noise ratio 59
Sky (VAIO Space) 23-24
sliders, moving 41
software

See also preinstalled software 
adding 26-27

problems with 84 
removing 28 

software demos 69 
Sony A/V Suite 3, 37 

components 38-39 
accessing 37 

exploring 40-78 
indicator lights 39 
opening 37

Sony e-mail support 79 
Sony Fax-back service 79 
Sony Multimedia Computer Display 3 

connecting 7 
setting up 5 
turning on 15

problems with 83



Sony Online 23 
Sony Online Support 17, 24 

options 79
Sony PC online registration 17 
Sony Sales and Marketing Support 79 
Sony VAIO Space 21 

adding icons 27, 32 
closing 34 
customizing 30-32 
exploring 23-35 
opening 34 
screen, described 22 

SOS hotline 80 
SOS icon 24 
SOS service 80-82 
SoundIWaster formats 60 
sound effects 31,49 

changing 55-60 
fading in or fading out 59 
mixing 40, 55

by copying over 60 
recording 50, 61
removing background noise 59 
undoing changes 59 

sound files See WAV files 
soundtracks, enabling/disabling 31 
speakerphones 8 

connecting 11 
technical support and 80 

speakers 3
adjusting volume 84 

AudioView 59, 60 
CD Player 43 
MIDI Player 63 
Mixer 40, 41 
Video File Player 71 
WAV Player 50 

connecting 7, 8 
precaution 111 
troubleshooting 84 

spinning icons (VAIO Space) 23, 29

starting
CD Player 42 
MIDI Player 62 
More A/V 77 
Video CD Player 74 
Video File Player 69 
WAV Player 49 

starting your computer 15 
problems with 83 

startup desktops 31 
stereo sound files 60 
stereo video CDs 75 
still pictures 75 
Stop play button 

AudioView 59 
CD Player 43 
MIDI Player 63 
Video CD Player 75 
Video File Player 71 
WAV Player 50 

surge protectors 109 
switching applications 33 
switching to Windows 95 34 
synchronized video playback 76 
system

rebooting 83
reformatting hard disk 87 
troubleshooting 83-86

T
taskbar 33

problems viewing 86 
technical specifications 79 
technical support 17, 24 

support options 79
telephones See phones; speakerphones 
temporary playlists 46 
text, selecting 105 
tracks

See also CD Player 
adding to playlists 46-47 
changing 43 
naming 45
removing from playlists 48
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Transforms menu (AudioView) 60 
Trim button (AudioView) 59 
troubleshooting 83-86 
turning off your computer 35,110 
turning on your computer 15 

problems with 83 
TV interference 111, 115

U
Undo button (AudioView) 59 
unpacking the computer 3 
"untitled" setting 42 
upgrading your computer 89,112 
UPS (Uninterrupted Power Supply) 

109
User Interface, selecting 31

VAIO Space See Sony VAIO Space 
VAIO Space Setting window 31 
ventilation 4, 111 
Video CD Player 74-76 

controls 75 
starting 74

Video File Player 69-73 
adjusting volume 71 
changing playlists 73 
controls 71
creating playlists 69-70 
display modes 71 
playing playlists 72 
starting 69 

video files 69
adding to playlists 69 
removing from playlists 73 
rewinding 71 
viewing 72

Video Playlist dialog box 69, 72, 73 
Video Wall (VAIO Space) 25 
videos See Sony A/V Suite 
viewing movies 31, 32 
viewing the taskbar 33 

problems with 86
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viewing video files 72 
VOC sound formats 60 
voltage settings 12,109 
volume, adjusting 84 

AudioView 59, 60 
CD Player 43 
MIDI Player 63 
Mixer 40,41 
Video File Player 71 
WAV Player 50

W
walls (VAIO Space) 25-28 

activating 25, 86 
warranty 17 
watching movies 31,32 
WAV files

adding to playlists 51 
converting formats 60 
copying segments 58-60 
copying to Clipboard 60 
creating 50,61 
cutting segments 55-57 
deleting background noise 59 
loading 49
pasting segments backward 60 
removing from playlists 54 
saving 61
undoing changes 59 

WAV Player 40, 49-54 
adjusting volume 50 
changing playlists 54 
controls 50
creating playlists 50,51-52 
editing sounds 55-60 
playing playlists 53 
recording sounds 50, 61 
starting 49

WAV Playlist dialog box 49,51, 53,54 
Web sites 23

e-mail support address 79 
Welcome icon 29
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NOTICE
This product contains software owned by Sony and licensed by third 
parties. Use of such software is subject to the terms and conditions of 
license agreements enclosed with this product. Some of the software may 
not be transported or used outside the United States. Software 
specifications are subject to change without notice and may not 
necessarily be identical to current retail versions.

Updates and additions to software may require an additional charge. 
Subscriptions to online service providers may require a fee and credit 
card information. Financial services may require prior arrangements with 
participating financial institutions. Some software titles are trial versions.

Sony and VAIO are trademarks of Sony. The Intel Inside logo and 
Pentium are registered trademarks of Intel Corporation. Microsoft, 
Windows, and the Windows 95 logo are trademarks of Microsoft 
Corporation. All other trademarks are trademarks or registered 
trademarks of their respective owners.

© 1996 Sony Electronics Inc. All rights reserved.

Reproduction in whole or in part without permission is prohibited.
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About the Contents of Your Sony PC

Your Sony PC includes the following items:

PC and Supplied Accessories



About the Contents of Your Sony PC

Manuals
□ About Your Sony PC provides descriptions of your preinstalled 

software titles and the specifications for your Sony PC.

□ Sony PC User Guide describes how to set up your PC, use VAIO™ 
Space (the Sony desktop), use the Sony A/V Suite, find help, upgrade 
your PC, and accomplish basic computer tasks.

□ Introducing Windows® 95 explains how to use the basic features of 
the Windows 95 operating system.

□ Introducing Microsoft® Phone teaches you how to use the Microsoft 
Phone speakerphone, answering machine, fax, and e-mail software.

□ 3D Movie Maker shows you how to create movies with the 3D 
Movie Maker application.

Wote
^ Your PC also includes a comprehensive hardware reference guide in the Sony PC 

Help Library on your hard disk drive. You can access this library from the Windows 
95 Start menu.

Other
□ Setting up your Sony PC (poster)

□ Packet containing Sony warranty information and special product 
offers

□ CD album containing Microsoft software license agreement, Sony 
end-user license agreement, and the following CDs:
□ The American Heritage® □ Microsoft 3D Movie Maker

Talking Dictionary □ Microsoft Encarta® 96
□ Billboard® Music Guide Encyclopedia

□ Blockbuster Entertainment® □ Microsoft Windows 95
Video Guide To Movies & Companion CD
Videos □ PC World's Multimedia LIVE!

□ Cartopedia: The Ultimate □ Quicken® Special Edition
World Reference Atlas □ Reader Rabbit 1®

□ Compton's Interactive □ Recovery CD
Encyclopedia™ □ Sony Welcome CD

□ The Eamily Doctor □ Video CD-ROM Sampler
□ LAUNCH™ □ WipeOut'" (Enhanced Edition)
□ MechWarrior®2 (Enhanced □ WOW!

Edition)



About the Software 
on Your Sony PC

Your Sony PC is ready to help you work, play, learn, and communicate as 
soon as you turn it on. This section gives you an overview of the activities 
you can perform with your software titles.

For general information, call Sony Electronics at 888-4SONY-PC 
(888-476-6972).

In the Work Center
Quicken® Special Edition
Intuit, Inc.
Quicken Special Edition helps you manage your personal and small business 
finances. The software resembles your checkbook, so it's easy to learn and 
easy to use. You can print checks, reconcile your bank account, and complete 
bank transactions from home. Quicken Special Edition's charts and graphs show 
you account balances and where your money goes. For questions and technical 
assistance, call Quicken at 505-896-7222, M - F, 6 am - 6 pm MT.

Investor Insight® (trial edition)
Intuit, Inc.
Investor Insight is a comprehensive, easy-to-use investment information 
service available for personal investors. It combines a full suite of investment 
analysis features—charting, company news, research reports, and personalized 
reports—with its own online service. With the click of a button. Investor 
Insight downloads late-bfeaking Wall Street information related to your 
stocks and mutual funds. For technical assistance, call Intuit at 708-585-8500,
M - F, 7 AM -11 PM CT, S - S, 8 AM - 5 PM CT.



About the Software on Your Sony PC

Microsoft Works for Windows 95
Microsoft Corporation
Microsoft Works is a suite of productivity tools that includes a word processor, 
spreadsheet, database, and drawing and communications software. You can use 
these tools to create professional documents quickly and easily. For questions and 
technical assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972),
7 days a week, 24 hours a day.

Microsoft Money
Microsoft Corporation
Display the status of your checking and savings accounts or check your loan 
and credit card balances. The software reminds you when it's time to pay a 
monthly bill and offers you the option to print your own checks or, if you make 
arrangements with your financial institution, pay the bills electronically. You can 
also prepare budgets and plan your financial future. Wizards help you set up new 
accounts, and online banking enables you to bank from home. For questions and 
technical assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972),
7 days a week, 24 hours a day.

Sidekick® 95 (trial edition)
Starfish Software
A personal organizer that keeps you on top of your schedule, client 
contacts, expenses, receipts, correspondence, telephone calls, and world time. 
Sidekick prints pages that fit into popular organizers from companies such as 
Day-Timer™, Day Runner®, Franklin®, and Filofax®. For questions and technical 
assistance, call Starfish Software at 900-555-1010 (charges appear on your phone 
bill) or 800-953-9995 (charges appear on your credit card), M - F, 6 AM - 5 PM PT.

PC411® Telephone Directory
PC411,lnc.
PC411 is your online North American telephone book and a complete source of 
411 information; over 108 million names, telephone numbers, addresses, and ZIP 
codes for all published business and residential phone book listings in the United 
States and Canada. Includes AT&T's 800 Directory. Search the entire country any 
time you need. Your first five searches are free. Charges apply for additional 
searches. For questions and technical assistance, call PC411 at 310-645-1114,
M - F, 8 AM - 5 PM PT.



In the Reference Library

In the Reference Library

%

Microsoft Encarta® 96 Encyclopedia
Microsoft Corporation
With more than 26,000 articles and nearly 300,000 links, this multimedia 
encyclopedia provides extensive information for school, work, and personal 
interests. Conduct research with a timeline that spans 15 million years. The 
Yearbook Builder provides current online updates. This software features 
"Sony Tuned" MPEGl Digital Video. For questions and technical assistance, call 
Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

Compton's Interactive Encyclopedia™ (1996 edition)
So/fKey® International Inc.
This 26-volume encyclopedia includes more than 35,000 articles, 8,000 pictures, 
and 100 full-motion videos. Listen to more than 15 hours of sounds, including 
famous speeches and recordings of historical events. The encyclopedia is valuable 
for students, families, and professionals. This software features "Sony Tuned" 
MPEGl Digital Video. For questions and technical assistance, call SoftKey at 
423-670-2020, M - F, 8 AM - 9 PM ET.

The American Heritage® Talking Dictionary
SoftKey International Inc.
More than an ordinary dictionary, this multimedia dictionary provides the correct 
pronunciation of 72,000 words. Use it to find full definitions of nearly 200,000 
words. Photos, illustrations, and videos clarify the meanings of many words.
This edition also includes a thesaurus with more than a million synonyms, the 
Dictionary of Cultural Literacy, and a special Quick View definition window. 
This software features "Sony Tuned" MPEGl Digital Video. For questions and 
technical assistance, call SoftKey at 423-670-2020, M - F, 8 am - 9 PM ET.

Cartopedia: The Ultimate World Reference Atlas
DK Multimedia
Cartopedia is an in-depth guide to the geographical world. This worldwide 
atlas includes detailed maps and up-to-date background information. A 
wealth of statistical data enables you to compare and contrast world statistics.
For questions and technical assistance, call DK Multimedia at 800-356-6575,
M - F, 9 AM - 7 PM ET.



About the Software on Your Sony PC

The Family Doctor - 4th Edition
Creative Multimedia™
The Family Doctor - 4th Edition is a resource for medical information.
This edition includes descriptions of more than 7,600 drug interactions and side- 
effects, explanations of first-aid techniques, and classifications of common 
symptoms and diagnoses. The software also covers alternative medicines, 
elements of human anatomy, and answers to more than 2,300 commonly asked 
medical questions. The material contained within The Family Doctor is for 
information only and should not replace the advice of your personal physician. 
This software features "Sony Tuned" MPEGl Digital Video. For questions and 
technical assistance, call Creative Multimedia at 900-438-8324 (charges appear on 
your phone bill), M - F, 8 am - 5 pm FT.

Blockbuster Entertainment® Video Guide to Movies & Videos - 2nd Edition
Creative Multimedia
Find out about movies before you watch them. This software includes more 
than 22,000 reviews, 5,500 photographs, 40 video clips, StarLinks™ interactive 
movie game, and 10,000 biographies and videographies. The Blockbuster Video 
Guide also offers free monthly electronic updates with reviews of the latest movie 
and video releases. This software features "Sony Tuned" MPEGl Digital Video. 
For questions and technical assistance, call Creative Multimedia at 900-438-8324 
(charges appear on your phone bill), M - F, 8 am - 5 pm PT.

Billboard® Music Guide
Creative Multimedia
The Billboard® Music Guide, with more than 60,000 albums in each of the 
major music genres, helps you find the music you want to own. This software 
includes more than 1,000 audio "sampling" clips, 38,000 reviews from Billboard‘S’ 
Magazine and the All Music Guidé’, graphics from more than 3,000 album covers, 
biographies, artist and band photos, credits, and Internet access. This software 
features "Sony Tuned" MPEGl Digital Video. For questions and technical 
assistance, call Creative Multimedia at 900-438-8324 (charges will appear on your 
phone bill), M - F, 8 AM - 5 pm PT.

LAUNCH
2 Way Media, Inc.
LAUNCH™, the bi-monthly entertainment CD-ROM. See and hear exclusive 
performances and interactive interviews from today's top musical artists. Enjoy 
behind-the-scenes interviews with movie stars and filmmakers. Discover original 
animated short films, plus game reviews and playable game demos. For questions 
and technical assistance, caU 2Way Media at 310-319-5320, M - F, 10 AM - 8 PM PT.



In the Reference Library

PC World's Multimedia LIVE!
PC World Magazine
LIVE! is a monthly CD-ROM magazine featuring the latest multimedia 
shareware, games, utilities, tips, and more. With this digital extension of the 
award-winning PC World magazine, you get software demos, clip art, music files, 
and up-to-date product reviews of the latest CD-ROM titles, creative tools, and 
multimedia hardware. Also included are behind-the-scenes video interviews with 
multimedia celebrities, movies, links to the hottest multimedia Web sites, and 
utilities for running and troubleshooting your multimedia system. For technical 
assistance, call PC World Magazine at 614-791-3747, M - F, 8:30 am - 5 PM ET.

Video CD-ROM Sampler
Sony Pictures Entertainment
The Video CD Sampler presents trailers from recent movies now available on 

~Tiome videos and distributed by Columbia Tristar Home Video®. Also includes 
trailers from current popular television programs distributed by Columbia 
Tristar Television Distribution™. This software features "Sony Tuned" MPEGl 
Digital Video. For questions and technical assistance, call Sony Electronics at 
888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

Sony PC Help Library
Sony Electronics
Sony PC Help Library gives you access to online user guides and help files 
for the software on your Sony PC. For questions and technical assistance, call 
Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.



About the Software on Your Sony PC

In the Game Arcade
WipeOut"
PSYGNOSIS LTD.
This game is set at a fictional racetrack of the future where there is zero gravity. 
Use the controls to navigate hairpin turns, make hang-ten drops, and initiate 
jumps. Your goal is to stay in the lead and defend your vehicle against other 
drivers. This enhanced edition includes ATI tuning. For questions and technical 
assistance, call PSYGNOSIS at 415-655-5683, M - F, 9 am - 5 PM FT.

MechWarrior® 2
Activision®, Inc.
Combining sophisticated simulation gameplay with vivid 3-D graphics, this 
action-combat game puts you in the cockpit of one of 15 'Mechs®, each 
customized with a variety of lethal weapons. Players battle across a number of 
planetary terrains, ranging from urban landscapes to icefields to deserts. The 
game is optimized for the ATI 3D RAGE accelerator chip, offering players higher 
polygon count real-time 3-D graphics with 65,000 colors. For questions and 
technical assistance, call Activision at 310-479-5644, M - F, 9 AM - 5 PM PT.

Dr. Black Jack (Best of Microsoft Entertainment Pack)
Microsoft Corporation
This classic casino game is a Windows favorite. Test your card-sense and luck 
as you try to reach 21. For questions and technical assistance, call Sony Electronics 
at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

FreeCell (Best of Microsoft Entertainment Pack)
Microsoft Corporation
In FreeCell, all the cards are on the table, but it still takes skill and practice to win. 
For questions and technical assistance, call Sony Electronics at 888-4SONY-PC 
(888-476-6972), 7 days a week, 24 hours a day.

Golf (Best of Microsoft Entertainment Pack)
Microsoft Corporation
You win this challenging solitaire game by matching the suits. For questions and 
technical assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972),
7 days a week, 24 hours a day.
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In the Game Arcade

TriPeaks (Best of Microsoft Entertainment Pack)
Microsoft Corporation
TriPeaks is a single-player card game. Your goal is to earn a higher score than 
anyone else who's ever played on your PC. Your success will depend on your 
perseverance, memory, and luck. For questions and technical assistance, call Sony 
Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

Tut's Tomb (Best of Microsoft Entertainment Pack)
Microsoft Corporation
Your lucky number is 13 in this solitaire card game. For questions and technical 
assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 
24 hours a day.

Taipei (Best of Microsoft Entertainment Pack)
Microsoft Corporation
Taipei is an ancient game from the Orient. Map your strategy to match all 
the tiles. For questions and technical assistance, call Sony Electronics at 
888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

TetraVex (Best of Microsoft Entertainment Pack)
Microsoft Corporation
Place your chips wisely in this four-sided game. Match the numbers as you 
complete the square. For questions and technical assistance, call Sony Electronics 
at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

Tetris™ (Best of Microsoft Entertainment Pack)
Microsoft Corporation
Tetris is the international favorite from Russia. Maneuver the blocks into 
rows to win. For questions and technical assistance, call Sony Electronics at 
888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

JezzBall (Best of Microsoft Entertainment Pack)
Microsoft Corporation
Trap the balls and beat the clock in this arcade-style game. For questions and 
technical assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972),
7 days a week, 24 hours a day.

Pipe Dream™ (Best of Microsoft Entertainment Pack)
Microsoft Corporation
The Pipe Dream maze game requires quick and decisive actions to avoid 
getting wet. Por questions and technical assistance, call Sony Electronics at 
888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.



About the Software on Your Sony PC

^ Chip's Challenge® (Best of Microsoft Entertainment Pack)
Microsoft Corporation
Navigate through many levels of puzzles and obstacles, including swamps, 
teleporters, ice, and killer balls. For questions and technical assistance, call Sony 
Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

Rodent's Revenge (Best of Microsoft Entertainment Pack)
^ j Microsoft Corporation

In this modern version of cat and mouse, a rodent scurries through a maze to 
trap the cat and win the cheese. For questions and technical assistance, call Sony 
Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

SkiFree (Best of Microsoft Entertainment Pack)
Microsoft Corporation
In this game, you steer a skier on a downhill slope. Choose a course—slalom, 
tree-slalom, or freestyle—and see how quickly you can make the skier reach 
the bottom. For questions and technical assistance, call Sony Electronics at 
888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

In Kid's Land
Microsoft 3D Movie Maker
Microsoft Corporation
With Microsoft 3D Movie Maker, children can create 3-D movies with special 
effects, sounds, music, and spoken dialog. Choose from more than 30 actors, 
select the costumes, and decide which camera angles to use. McZee™ and Melanie 
are characters who offer tips and help along the way. Eor questions and technical 
assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 
24 hours a day.

Reader Rabbit 1 & The Learning Company Sampler
SoftKey International Inc.
Reader Rabbit helps youngsters build their preschool and first-grade reading 
skills. The rabbit leads children on a tour of the Word Eactory, where they play 
games that use time-tested educational techniques. Animated graphics and lively 
sounds enhance the experience of recognizing letters and words. For questions 
and technical assistance, call SoftKey at 423-670-2020, M - F, 8 AM - 9 PM ET.
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IntheA/V Wall

In the A/V Wall
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CD Player
Use the CD Player to listen to audio CDs in your CD-ROM drive while you use 
your computer. You can play specific tracks, shuffle tracks in random order, or 
create a playlist of selected tracks. Software created by Voyetra™ Technologies. 
For questions and technical assistance, call Sony Electronics at 888-4SONY-PC 
(888-476-6972), 7 days a week, 24 hours a day.

WAV Player
Many of the sounds you hear on your Sony PC are WAV files. The WAV Player 
lets you play WAV files as well as create playlists of your favorite sounds and 
save the sequences to hear later. Software created by Voyetra Technologies. For 
qtwstions and technical assistance, call Sony Electronics at 888-4SONY-PC 
(888-476-6972), 7 days a week, 24 hours a day.

MIDI Player
Connect a MIDI instrument to the built-in MIDI connector and you can record 
your own MIDI files. The MIDI Player also makes it easy to play existing MIDI 
music files and to make playlists for future listening sessions. Software created by 
Voyetra Technologies. For questions and technical assistance, call Sony 
Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

Audio Mixer
With the Audio Mixer, you can adjust the volume for all the sound sources 
on your Sony PC. Use the Audio Mixer to make the audio in your multimedia 
software and audio CDs sound just the way you like. The Audio Mixer also 
controls auxiliary devices and microphone input. Software created by Voyetra 
Technologies. For questions and technical assistance, call Sony Electronics at 
888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

Video File Player
Watch movies on your Sony PC with the Video Pile Player. This video player 
functions like a VCR and plays AVI and MPEGl video format files. You can make 
playlists of video files and save the lists for future viewing. Software created by 
Voyetra Technologies. For questions and technical assistance, call Sony 
Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.
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About the Software on Your Sony PC

Video CD Player
The Video CD Player in your Sony PC enables you to play Video CDs. Use it alsc 
as a Karaoke player, to sing along with Karaoke CDs. Or watch music videos on 
enhanced CDs and access bonus information about your favorite musicians. 
Software created by CompCore Multimedia, Inc. For questions and technical 
assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 
24 hours a day.

Microsoft Phone
Microsoft Corporation
Turn your Sony PC into a speakerphone. Microsoft Phone transforms your 
modem into a comprehensive, centralized communications center. Store all 
e-mail, voice, and fax messages in a single inbox. Let callers hear announcements 
leave messages, or receive faxes by pressing their phone keys. Use text-to-speech 
technology to read e-mail messages aloud over the phone. Microsoft Phone uses 
speech-recognition technology to enable you to store frequently used numbers ir 
memory and to dial by simply pronouncing a name. For questions and technical 
assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 
24 hours a day.

AudioView™
With AudioView you can record your own sounds, add prerecorded sounds, anc 
change or edit the existing sounds on your Sony PC. Familiar copy, cut, and past« 
commands make it easy to get started. You can also perform more sophisticated 
functions such as mix pasting, combining several sounds, and adjusting playbacl- 
volume. Software created by Voyetra Technologies. For questions and technical 
assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 
24 hours a day.
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In Net Space

In Net Space
DeltaPoint® QuickSite™ (trial edition)
DeltaPoint, Inc.
Create and manage your own site on the World Wide Web with QuickSite. 
Wizards guide you as you design, structure, and organize the pages. Predesigned 
components give you a head start. When you're ready to publish your World 
Wide Web site, QuickSite generates the HTML code, builds the links, logs on to 
your Internet Service Provider, and transfers the files. For questions and technical 
assistance, call DeltaPoint at 800-446-6955, M - F, 7 AM - 5 PM PT.

Internet Explorer for Windows 95
Microsoft Corporation
Internet Explorer is the Internet browser included with Microsoft Plus! The 
Setup Wizard configures your computer to connect automatically to the service 
provider of your choice. A full e-mail package enables you to send and receive 
mail—including attached files—across the Internet. If you do not currently have a 
service provider, Internet Explorer connects you to the Internet using MSN,
The Microsoft Network™. A complete online tutorial helps new users become 
comfortable using the Internet. For questions and technical assistance, call Sony 
Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

A

Netscape Navigator™ Personal Edition
Netscape Communications
Netscape Navigator gives you easy access to all major Internet resources.
Browse ever-growing sources of information on commerce, current events, travel, 
entertainment, and more. Netscape Navigator is the most widely used World 
Wide Web browser in the world. For questions and technical assistance, call 
Sony Electronics at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.

America Online®
America Online
America Online is an online service with an intuitive interface. Use America 
Online to stay on top of the news and track your personal finances. Find support 
for computer products and download software and files. Read issues of your 
favorite magazines, take online accredited courses, connect with homework 
tutors, and chat with thousands of members. You also receive your own e-mail 
account. For technical support, caU America Online at 800-827-3338, 7 days a 
week, 6 AM - 2 PM ET.
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About the Software on Your Sony PC

j WOW!
CompuServe, Inc.
WOW! from CompuServe is a consumer online service created for home 
and family use. WOW! offers each household member access fo information, 
entertainment, communications, and the Internet, combined with the flexibility 
to customize and control the online experience. WOW! includes e-mail services, 
multimedia, and distinct online views for adults and children. In addition, stror 
parental access options are available. For technical support, call CompuServe at 
800-943-8969,7 days a week, 24 hours a day.

WinCIM® CompuServe Information Manager
CompuServe, Inc.
A comprehensive online information manager that enables members to select 
a wide range of information services. CompuServe's WinCIM provides access t' 
the Internet, latest breaking news, weather reports, stock quotes, travel and 
leisure information, games, entertainment, electronic mail, electronic shopping, 
restaurant reviews, and movie reviews. For technical support, call CompuServe 
at 800-848-8990, M - F, 8 AM - 1 PM FT, S - S, 10 AM -10 PM FT.

Cyber Passage
Sony Electronics
Cyber Passage is the first VRML-based (Virtual Reality Modeling Language) 
Internet web browser. VRML is the 3-D equivalent of HTML (HyperText Marki 
Language), converting the VRML language to a 3-D world of animated shapes, 
sights, and sounds. Use your mouse to travel between hyperlinked 3-D space 
objects. Share objects with multiple users. This version of CyberPassage is 
automatically invoked by Netscape Navigator when viewing VRML data. For 
questions and technical assistance, send e-mail to info@sm.sony.co.jp.
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other Software

Other Software
Sony Welcome CD
Sony Electronics
The Welcome CD provides a peek at the wide variety of applications 
included with the Sony PC: movies, music, games, magazines, online 
services, education, finance, and more. Through its graphically rich, interactive 
environment, the Welcome CD also offers a glimpse of how your PC's 
sophisticated technology creates a dynamic, multisensory experience. This 
software features "Sony Tuned" MPEGl Digital Video. For questions and 
technical assistance, call Sony Electronics at 888-4SONY-PC (888-476-6972),
7 days a week, 24 hours a day.

Microsoft Plus!
Microsoft Corporation
Microsoft Plus! is a companion to Windows 95. Plus! helps you access the 
Internet and tune your PC, performing tasks such as disk optimization and 
error correction. In addition. Plus! provides 12 colorful desktop themes and 
the 3-D Pinball game. For questions and technical assistance, call Sony Electronics 
at 888-4SONY-PC (888-476-6972), 7 days a week, 24 hours a day.
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Specifications

Specifications

Model Number PCV-70 PCV-90
Processor 166 MHz Pentium 200 MHz Pen
Hard Disk Drive 2.1 GB 2.5 GB
Standard RAM 32 MB EDO RAM, expandable to 128 R
L2 Cache Memory 256 KB Pipeline Burst SRAM
Video RAM 2 MB EDO Video RAM
MPEG "Sony Tuned" MPEGl Digital Video 

supports full-screen playback
Graphics 3-D acceleration
Sound Capabilities 3-D SRS surround sound 

16-bit audio EM synthesis 
Wavetable synthesis 

MPC-3 compliant
Diskette Drive 3.5" 1.44 MB MFDD
CD-ROM Drive 8X CD-ROM drive
CD-ROM Laser Semiconductor laser GaAlAs 

780 nm wave length 
0.6 mW output power 

53.4 ±1.5 degrees beam divergence
Modem 28.8 Kbps DSVD modem 

14.4 Kbps fax
Telecommunication Eull duplex speakerphone with echo cance
Capabilities Answering machine functionality witi 

personal mailboxes 
Eax send/receive

Expansion Capabiiities Two PCI slots 
Two ISA slots 

One shared PCl/ISA slot 
MIDI/game port 
Two USB ports*
Two drive bays

Suppiied Accessories Keyboard
Mouse

RJ-11 Phone Cable 
Power Cord
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Service One-year on-site standard^
Limited Warranty One-year parts/labor standard*
Power Requirements 200 watts maximum
Dimensions 9" (w) X 14 7/8" (h) X 18" (d) (226 x 376 x 455mm)
Weight 22 lbs. (10kg)
Operating Temperature 50° F to 95° F (+10° C to 35° C)

* USB ports are included to provide state-of-the-art technology. Until USB 
support is available at the operating system level, you must supply drivers to use 
USB devices. You can upgrade your operating system to a version that supports 
USB at the operating system level once a version becomes available.

+ Certain restrictions apply.

Specifications are subject to change without notice.

This product meets the standards of the International ENERGY STAR 
Program for energy efficiency.
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